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Section 1. Getting Started

Thank You

Thank you for purchasing FlashCut™ CNC, the intuitive, powerful CNC control
system for Windows". No system is easier to set up and use than FlashCut CNC.
You’ll appreciate its intuitive controls and real time graphics as you quickly and
accurately cut parts on your machine tool.

We are very committed to the excellence and ongoing enhancement of FlashCut
CNC. Feel free to call us with any comments or questions.

Product Support

We are committed to full support of FlashCut CNC products. Please contact us
by email, phone or fax as follows:

West Coast
Phone:  (650) 853-1444 (9:00 AM-5:00 PM, PST, M-F)
Fax: (650) 853-1405

East Coast
Phone: (301) 718-7300 (9:00 AM-5:00 PM, EST, M-F)
Fax: (301) 718-7301

Internet
E-mail:  support@flashcutcnc.com

Web Site: www.flashcutcnc.com

New Features

We are constantly adding new features and capabilities to FlashCut CNC. Some
of the important new features in the last two major software releases are:

Version 1.3 (Spring 1999)

» Continuous Contouring

e Canned Cycles (G73, G81, G83)
e New Homing Options

e Medium Jog Rate

» Many New Configuration Settings
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Version 1.4 (Summer 1999)

e 4th Axis Support (Rotary or Linear)
* Monitoring Input Lines

e Subroutine Libraries

» Looping (in M98 Command)

e Main Screen Layout Updated

System Requirements

* IBM PC or 100% compatible with a 100MHz or faster 80486DX (Pentium or
comparable processor preferred).

* At least 16MB of RAM (at least 64MB preferred for large G-code files).
e Hard drive with at least 20MB of space available.

» 3.5inch, 1.44 MB floppy disk drive.

* VGA, SVGA or compatible video monitor.

* A Microsoft-compatible mouse. Note that for best performance, the mouse
should connect directly to the bus (the standard mouse plug on most systems),
or through a mouse bus port rather than through a serial port.

* One available RS-232 serial port. If the port has a 25-pin connector, a 9-pin
male to 25-pin female adapter will be required.

e Microsoft Windows 95, 98 or NT or Microsoft or PC DOS version 3.1 or later
running Microsoft Windows version 3.1 or 3.11.

Installing FlashCut CNC

It’s a good idea to make a working copy of the FlashCut CNC disks and put the
originals away in a safe place, before installing the program. Then if the working
copy is damaged or lost, you can easily replace it.

If you are using Windows 3.1 or 3.11:
1. Start Windows
2. Place Disk 1 into drive A or drive B.

3. Inthe Windows Program Manager, choose the Run command from the
File menu. Inthe Command Line text box, type a:setup if you are
using disk drive A or b:setup if you are using disk drive B. Choose
the OK button and follow the on-screen instructions.

4. To run FlashCut CNC simply double-click on the FlashCut CNC icon
in the FlashCut CNC program group.
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If you are using Windows 95, 98 or NT:
1. Start Windows
2. Place Disk 1 into Drive A or Drive B.

3. From the Start menu, choose the Run option. In the Open text box,
type a:setup if you are using disk drive A or b:setup if you are using
disk drive B. Choose the OK button and follow the on-screen
instructions.

4. To Run FlashCut CNC, choose the Programs option from the Start
menu, then choose the FlashCut CNC program group, then choose the
FlashCut CNC program icon.

Using the Mouse

Most mice have two buttons. When using FlashCut CNC, always use the left
mouse button unless specifically instructed otherwise. The following table
explains basic terms associated with using the mouse.

To Do this

Point Position the pointer (arrow) on an item.

Click Point to an item, and then quickly press and release the mouse
button.

Double-click Point to an item and then quickly press and release the mouse

button twice.

Drag Point to an item, press and hold the mouse button as you move the

mouse to a new location. Then release the mouse button.

Hold Point to an item, press and hold the mouse button.

Choosing Commands

A command is an instruction that tells FlashCut to perform a task. You can
choose a command by:

1.

2
3.
4

Choosing a command from a menu with your mouse.

. Choosing a command from a menu with your keyboard.

Using shortcut keys.
Using the TAB and ARROW keys.

Choosing a Command by Using the Mouse

Click the name of a menu item on the menu bar, then click the command name.
To close the menu without choosing a command, click outside the menu.
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Choosing a Command by Using the Keyboard

Press ALT or F10 to make the menu bar active, and then press the key
corresponding to underlined letter in the menu name. To choose a command,
press the key corresponding to the underlined letter in the command name. To
close a menu without choosing a command, press ESC.

Using Shortcut Keys

Some of the FlashCut commands have shortcut keys associated with them. You
can choose these commands by pressing the shortcut keys listed on the menu to
the right of the command.

Using the TAB and ARROW Keys

The TAB key and ARROW keys can be used to navigate through the currently
active screen selections. Once the selection that you want is highlighted, use the
RETURN key to select it.

Using Standard Windows Controls

FlashCut uses several standard Windows controls: radio buttons, pull-down
menus, text boxes and command buttons.

Radio Buttons
Radio buttons represent a group of options, of which only one can be selected at a

time.
I IX Paoint | Hgme' A |
Z+ Y+ A+ " Fast ——
_—— Radio Buttons
" Med i
X - X+ -
|_ &+ Slow
| Single
Z- Y - A - | t"‘ Step

Pull-Down Menus

A pull-down menu is a list of commands that appears when you select either a
menu or a down-arrow icon.

Text Boxes
Text boxes are areas in which you type either a name or a value.
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Command Buttons
Command buttons perform a specific task when selected.

Home | Aug | | Pull-Down Menu

x| _GcCd|

m IIncrementaI j IFeedrate j |_——— Text Box

AN

Program fero
Machine Fero X IDDDDD If I"IDDDDyfmJ/
“/min

Relative fero Ii _
Tool Change L " 7200 P Command Button
Program Start Iil:| 0no0 : = -

Curr. Line Start Z I Hove

Last Feed Hold A IIII_EIEIIZI ° Feed Hold
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Safety and Usage Guidelines

When running an automated machine tool, safety is of utmost importance.
For proper and safe use of the FlashCut CNC program and your CNC
machine, the following safety guidelines must be followed:

1. Never let the machine tool run unattended.

2. Require any person in the same room as a running machine tool to wear
safety goggles, and to stay a safe distance from the machine.

3. Allow only trained operators to run the machine tool. Any operator must
have:

Knowledge of machine tool operation.
Knowledge of personal computer operation.
Knowledge of Microsoft Windows.

Good common sense.

4. Place safety guards around the machine to prevent injury from flying
objects. It is highly recommended that you build a safety shield around
the entire tool envelope.

5. Never place any part of your body within the tool envelope while the
machine is online, since unexpected machine movement can occur at any
time.

6. Always keep the tool envelope tidy and free of any loose objects.
7. Beon alert for computer crashes at all times.

WHPI, Inc. is not responsible for the safe installation and use of this product.
You and only you are responsible for the safety of yourself and others during
the operation of your CNC machine tool. WPI supplies this product but has
no control over how it is installed or used. Always be careful!

WHPI, Inc. is not responsible for damage to any equipment or workpiece
resulting from use of this product.

If you do not understand and agree with all of the above, please do not use
this product.
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About this Manual

FlashCut CNC is a unique Windows application, so you’ll need some instruction
to get started. Since automated machining is potentially dangerous, please
take the time to completely read through this manual to understand
operation of the software before running the system.

Please note that all FlashCut CNC terminology appears in boldface upon first
occurrence and is defined in the glossary.

It is assumed that you already have a working knowledge of the PC and
Windows. If you are not familiar with either of these, please review your PC or
Windows user’s guides before you use FlashCut CNC.
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Section 2. Main Screen Features

The main screen is shown below. An explanation of each area of the screen

follows.
Pull-Down F FlashCul CME - GASKET FGE - FLASH140.5TP Hl-_E
Menu Bar B Sehn Corbely Wew Coojnotes e =~~~
* : . -, | Program _s= | o] Machine ce| 2|
— : X 2.3975 (X 3.3975
Tool Position = = Ul 4.5170 |7 5.5170
Box z -0.1000 [z -0.8500
ITI' 4 f . o0.000 |a ©0.000
e pa : / ' F:Imz %I?il n}:nn ?3975
View Port : ~ Ml 45170 1.0170
)" Jljz -0.1000 |2  0.0000
Message Box 1 - LA 0.000 A 0.000
Control ! T r—
ontro T
Selection Box : : xi- G| o | pow | Hgme | suy |
EOE Dl || . Tk [1 - 265 3 End Wil =
Control Panel |ty rmmr—+ - Far ———
B 2 0. 1050 Shervur | 00 | & deebdec 5o 0
Program et iinny e Boeet | T Ewe ¥ Copeures
Listing Box 009 % L5000 ¥ 5.2500 I 0.Z500 § 0.0000 F 25,
B0 2 01000 = Start Feed Hold (@ny Key |

Pull-Down Menu Bar

This area contains the main menu headings for many system commands.

File Menu
¥ FlashCut CNC - No G-Code File Dpen - FLA
File Setup Controller “iew Coordinates Help
Open G-Code...  Chl+0
Cloze G-Code
Editor... Clrl+E
Open Setup...
Save Setup
Save Setup Az
Impart DXF... Chlsl 1
E xit
| | |

Open G-Code - Opens an existing G-Code file, checks the file for errors and
compatibility with FlashCut, draws the toolpath in the Toolpath View Port, and
displays the program in the Program Listing Box. By default, the dialog box
displays files with an “.FGC” extension.
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Close G-Code - Closes the open G-Code file.

Editor - Opens the editor dialog box and displays the current G-Code file. Using
this feature you can directly edit any G-Code file without leaving FlashCut. Note
that you can also double-click the Program Listing Box to open the editor.

Open Setup - Opens a file containing all CNC setup parameters for your
machine tool. You can set these parameters using commands in the Setup and
View menus described below. Setup file names have a “.STP” extension by
default.

Save Setup - Saves the current CNC setup parameters under any file name in any
directory.

Save Setup As - Prompts you for a file name in which to save the current CNC
setup parameters.

Import DXF - Directly translates a 2-dimensional DXF file into G-Code for use in
FlashCut.

Exit - Closes the communications port to the Signal Generator, then exits the
program. This does not automatically turn off the Signal Generator, motor
driver or other electronics in your system. You must turn off all electronics
separately.

Setup Menu

# FlashCut CNC - Ho G-Code File Open - FLA

File | Setup Controller  Wiew Coordinates  Help

2 tachine Tool...
Eeedrate/Famping...
Tooling...

Input Lines. ..
Output Lines...
kotor Signals. ..
G/ Codes. .
Mezsages...

1
"

[mpaort...

System Options...

| =T

Machine Tool, Feedrate/Ramping, Tooling, Input Lines, Output Lines, Motor
Signals, G/M Codes, Messages, Import, System Options - Open dialog boxes
where you’ll enter your CNC setup parameters, such as the size of your machine
tool envelope or the configuration of your Signal Generator. These parameters
are described in detail later in the manual.
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Controller Menu

_j FlazhCut CNC - No G-Code File Open - FL{

File Setup | Controller Miew Coordinates  Help

a1 Online
v Offline

o+

Input Status. .

Online - Establishes communications with the Signal Generator. Once
communications are established, FlashCut places a check mark next to this menu
item. When the Signal Generator is online, all move commands will be executed
by the machine tool, and the screen will update in real time.

Once the unit goes online, a safety reminder screen appears. It is imperative that
you and anyone else near the machine understand, agree and adhere to all of the
safety guidelines. If the safety guidelines are not agreed to, the unit will
immediately go offline.

§ Safety Firztl

Safety First!

FlashCut CHC iz now online. ALL MOVES WILL BE EXECUTED BY THE MACHIME
TOOL.

A computer controlled machine tool is potentially dangerous. You are responsible
for the safety of yvourself and others during the operation of your CHC machine. Far
safe use ofthe FlashCut CHC software and your CHMC machine, you must follow
these safety guidelines:

1. HNewer let the machine tool run unattended. ﬂ

2. Bequire any person in the same room as a runhing machine
tool to wear safety goggles, and to stay a safe distance from
the machine.

3. 4Allow only trained operators to run the machine tool.  Any
operator must have:

[fyou do not understand and agree with all ofthe ahowve safety guidelines, please
choose Ga Offline below.

Go Offline Agree

Offline - Breaks communication with the Signal Generator. When the Signal
Generator is offline, FlashCut places a check mark next to this menu item. In this
mode, the screen will update, but the machine tool will not move. This option lets
you “animate” a G-Code file, which is useful for debugging before cutting a part.
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Input Status - Shows the current status of the input lines. The following dialog
box is displayed:

¥ Input Status
—Input Lines
Line Description Status

1 *- Limit Closed
2 o+ Limit [Closed
3 ¥- Limit [Closed
4 ¥+ Limit [Closed
5 T+ Limit [Closed
G Enclosure Daoar Closed
Fi Indexer Position 1 [Closed
g Indexer Position 2 [Closed

View Menu

¥ FlashCut CNC - Mo G-Code File Open - FLASH141. 5TP

File Setup  Contoller | Yiew Coordinates Help
gl T | v Scale to Fit Chrl+F

L Program Coordinates
Machine Coordinates
104 Relative Coordinates
Digtance To Go Coordinates

T ﬁl v Al Coordinates
t |

Scale to Fit - Causes the toolpath of the current G-Code File to expand as much as
possible within the Toolpath View Port. When this option is not chosen, the
Toolpath View Port displays the entire work envelope.

Program, Machine, Relative, Distance To Go, or All Coordinates - Selects the
display mode for the Tool Position Box. Choosing either Program Coordinates,
Machine Coordinates, Relative Coordinates, or Distance To Go Coordinates
will expand the chosen Coordinate System Display into the entire Tool Position
Box as shown below.
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Program Coordinates _ Set | [£17]
% 0.0000
’ 0.0000
4 0.0000
A 0.000

Choosing All Coordinates will display all four coordinate systems simultaneously
in the Tool Position Box. You can also change these view modes by double-
clicking any of the Coordinate System Displays.

Coordinates Menu

3 0 pde e Upe =
File Setup Controller Miew | Coodinates Help
21 Y Zero Program  Cil+P

2ero Machine
Zern Belative

o+

30 Set Program  Chil+G
Set Relative

1 Iﬁl Clear Machine
207

The commands in the Coordinates menu exactly match the buttons in the Tool
Position Box. The main purpose of this menu is to provide keyboard equivalents
and shortcuts for the buttons. See “Tool Position Box” later in this section for a
complete explanation of each command.

Zero Program - Same as the Zero (0) button next to the Program coordinates
label.

Zero Machine - Same as the Zero (0) button next to the Machine coordinates
label.

Zero Relative - Same as the Zero (0) button next to the Relative coordinates label.
Set Program - Same as the Set button next to the Program coordinates label.
Set Relative - Same as the Set button next to the Relative coordinates label.

Clear Machine - Same as the Clear button next to the Machine coordinates label.
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Help Menu

_j FlazhCut CNC - Ho G-Code File Open - FLASH141.5TP

File  Setup Controller  Wiew Coordinates | Help
a1 T | About FlaghCut CHL. ..
[

About FlashCut CNC - Shows the FlashCut CNC software version number.

Tool Position Box

The tool position box shows the current tool position in terms of Program,
Machine, Relative and Distance to Go coordinates. It also has command buttons
that affect the coordinate values.

Program _ssN ™Machine _cea{{a] |

Clear Button

X
Y
7 . Zero Button
A 0.000 .

Set Button
Relative _set | 0 | ﬁi\tTn Go

X 0.0000 |X 0.0000 Coordinate System
) §

0.06Q0 | 0.0000 Label

Y
z  0.0000 0.0000
A 0.000 i\o\.nnn

Coordinate Systems

Program

Displays the coordinates of the current position of the tool relative to Program
Zero.

Coordinate System
Display

Machine

Displays the coordinates of the current position of the tool relative to Machine
Zero. This coordinate system is undefined if Machine Zero has not been set
(displays “N/A”).

Relative

Displays the current relative coordinates. The relative coordinate system is
general purpose and may be used for anything you choose. For instance, to
measure the distance from any point in the program without having to use the
Program or Machine coordinates, just zero the relative coordinates at the point
from which you want to measure.

Distance To Go

Displays the distance to the ending position of the current move.



FlashCut CNC Section 2 Main Screen Features 15

Note that you can double-click any Coordinate System Display to expand it to fill
the entire Tool Position Box.

Command Buttons

Zero Button - Sets X, Y, Z and A values of the indicated coordinate system to
zero.

Set Button - Allows setting the X,Y Z and A values of either Program or Relative
coordinates to any value. When chosen, the following dialog box appears:

_f Set Program Coordinates

—MNew Values

¥ (0.0000 inches fero A
¥ (0.0000 inches fero ¥

Z [0.0000 inches fero £

1

A [0.000 = Fero A

Cancel

‘

» To set new values within a coordinate system

1. Typeinthe X, Y, Z and A values for each axis. These coordinates will
become the current position of the tool.

2. Choose OK.

» To zero specific axes individually
1. Choose the Zero button for each axis you want to zero.
2. Choose OK.

Clear Button - Clears the current Machine Zero setting. This button is useful
when you’ve set Machine Zero manually (using the Machine coordinates Zero
Button) and need to make a correction to the Machine Zero location.

Toolpath View Port

The figure below shows the Toolpath View Port. The XY Grid represents an
aerial view of the tool envelope. The Z Scale represents the height of the tool
during machining. Green and light blue dots represent the origins of the Program
and Machine (if used) coordinate systems respectively. The Machine Tool



16

FlashCut CNC Section 2 Main Screen Features

Envelope is shown as the light blue box on the XY Grid and by the light blue bar

on the Z Scale.

Z Y
21

XY Grid

Program Zero

Machine Zero

Machine Tool
Envelope

10

15

X

Z Scale

The figure below shows the Toolpath View Port during the machining process.
The bottom of the blue tool icon adjacent to the Z scale represents the current Z
position of the tool. The yellow dot on the XY Grid represents the current
position of the tool. The red outline in the XY Grid represents the toolpath of the
entire G-code program. The red bar along the Z Scale represents the total Z
travel. Blue represents the portion of the toolpath that has already been cut. Solid
lines depict feedrate moves while dashed lines represent rapid moves.

P T
21

i

Total Z Travel

)

Current Z Height

Program Tool Path

(Red)

Current XY

Position (Yellow)

Rapid Move

(Dashed)

Path Already Cut

(Blue)
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Control Selection Box

The Control Selection Box has buttons to display the five Control Panels.

E-Cd| Jog I Euintl Hgmel J—Kugl

All of the controls you’ll need to run your machine tool are located on these
panels as follows:

G-Cd  Controls to move the tool along the toolpath specified by a G-Code
program.

Jog Controls to manually move the tool in all four axes.
Point  Controls to move the tool to any point specified.
Home Controls to seek the home switches for all four axes.
Aux Controls for turning auxiliary devices on or off.

To switch between panels, simply click on the appropriate button. Each control
panel is described below.

G-Code Control Panel

The G-Code Control Panel provides controls to move the tool as directed by the
current G-Code program.

E-Cdl Jog I Paint | Hng! Al ! Current Tool Pull-
Down Menu

Curr. Took: [#1- 3116 Ball End Mill 2 Flute x|

Feedrate Override

Faster l| Prograrm Feedrate: [ 30, 0 Buttons
Slowver | I ID@' %Dverrideilﬁﬂ.ﬂ

Feedrate Override

Reset " Step @ Continuous 71— p,;|.Down Menu

Start Feed Hold {Any Key)

Continuous / Step Radio Buttons - Sets the G-Code file processing mode. In
continuous mode, the G-Code program runs non-stop. In Step mode, the G-Code
program executes one line at a time. You can switch between step and continuous
modes while the machine is moving. When continuous contouring is turned on,
both buttons are disabled and the system always runs in continuous mode.

Start Button - Begins execution of the current line of the G-Code file. When in
Step mode, execution will stop automatically at the end of the current line, or
when the Feed Hold button is hit. When in Continuous mode, execution
continues until the end of the program, or until the Feed Hold button is hit. If the
program has been stopped in the middle of a G-Code line, choosing the Start
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button will begin execution exactly where the program stopped. Note that all
moves begin with ramping when necessary.

Feed Hold Button - Stops execution of the G-Code file. The machine tool will
stop, ramping down if necessary to avoid loosing steps. The slower the ramping
rate, the longer it will take from the time the Feed Hold button is hit to the time
the tool comes to a complete stop.

You can also stop the machine tool by hitting any key on the keyboard (except
Shift or Ctrl).

Reset Button - Resets the current G-Code file to the first executable line and
refreshes the Toolpath View Port.

Current Tool Pull-Down Menu - Displays the current tool loaded in the machine
tool. Note that FlashCut uses this setting for tool length compensation (see
System Programming for more information).

Feedrate Override Buttons and Pull-Down Menu - Increases or decreases the
feedrate on the machine as a percent of the programmed feedrate. During linear
interpolation moves (GO1) you can gradually change the feedrate using the Faster
or Slower buttons. The Faster and Slower buttons are disabled during circular
interpolation and rapid moves. When the machine is stopped, you can enter an
exact feedrate override percentage by choosing a value from the Feedrate
Override pull-down menu (or typing in any value). Both the programmed
feedrate and the override feedrate are displayed. Rapid moves are not affected by
the feedrate override.

You can use the keyboard instead of the Faster/Slower buttons as follows:

Faster Ctrl + Up Arrow Key
Slower Ctrl + Down Arrow Key

When continuous contouring is turned on, the Faster and Slower buttons are
disabled, and the Feedrate Override pull-down menu is disabled while a G-Code
file is in progress. However, the Feedrate Override pull-down menu is available
before running a G-Code file.

Jog Control Panel
The Jog Control Panel provides controls for manually positioning all axes.

Enint| Hgme' A |

Axis Jog Buttons

A+ i~ Fast

| " Med
|_ * & Slow M Jog Rate

Single
A- b Step
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AXis Jog Buttons

You can move a single axis of your machine tool by pressing and holding an Axis
Jog Button. Ramping is used if the jog rate is faster than the maximum unramped
feedrate for a given axis. Note that you can also jog the machine using the
keyboard. The controls are mapped as follows:

X+  Ctrl + Right Arrow Key
X- Ctrl + Left Arrow Key
Y+  Ctrl + Up Arrow Key
Y- Ctrl + Down Arrow Key
Z+ Ctrl + Page Up Key

Z- Ctrl + Page Down Key
A+  Ctrl + Plus (+) Key

A- Ctrl + Minus (-) Key

Jog Rate

Single Step - Sets FlashCut to move exactly one motor step each time an
Axis Jog button is chosen.

Slow, Medium and Fast - Sets the jog rate to the corresponding rate
specified in the Feedrate/Ramping Setup dialog box. Note that there are
separate jog rates defined for linear and rotary axis types.

Point Control Panel

The Point Control Panel provides controls for moving the tool to the XYZA
position you enter at the feedrate you specify.

The sequence of axis motions follows a general-purpose scheme based on three
fields in the Machine Tool Setup dialog box: Home End, Home Order, and Point
Move Linear Interpolate. These fields should be configured to allow for safe
moves in Point mode, which generally means the tool retracts from the workpiece
before any other motion occurs. FlashCut uses the following sequencing rules:

1. Do all non-interpolated moves that are towards the Home End, in the Home
Order.

2. Do the interpolated move, if any.

3. Do all non-interpolated moves that are away from the Home End, in reverse
Home Order.

By setting the three Machine Tool Setup fields you can make the sequence safe
for your machine tool configuration.

In a typical sequence for a 3-axis mill, any move with a positive Z axis element
will first move up to the desired Z coordinate and then move across to the desired
XY position. Any move with a negative Z axis element will first move across to
the desired XY position and then move down to the desired Z position. This is
the default behavior in the mill setup files provided with the FlashCut CNC
software.
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The G28 and G29 commands (described later in the System Programming

section) follow the same scheme.

Point List

Coordinate System
Pull-Down Menu

Program fero
Machine fero
Relative fero

x|D.|:u:|DD in |1|:u:|. infmin

m IIncrementaI j IFeedrate \ll\\

Rate Mode Pull-
Down Menu

Linear Feedrate

y [L0000 i |?zn.?9%
Z ID.DDDD i Move

Tool Change Text Box
Program Start

Curr. Line Start Rotary Feedrate
Last Feed Hold A IEI.EIEIEI = Feed Hold Text Box

Point List
Provides a list of move options as follows:
Any Point - Moves to any XY ZA point in the selected coordinate system.
Program Zero - Moves to Program Zero.
Machine Zero - Moves to Machine Zero (if defined).
Relative Zero - Moves to Relative Zero.

Tool Change Position - Moves to the Tool Change Position defined in
Machine Coordinates in the Machine Tool Setup dialog box.

Program Start Point - Moves to where the tool was located when the
current G-Code program was started.

Current Line Start Point - Moves to where the tool was located when the
current G-Code line began execution.

Last Feed Hold Point - Moves to where the tool was located when G-Code
execution was stopped by the Feed Hold button.

Note that you can select each item in the Point list using the keyboard as

follows:

Any Point Shift+1
Program Zero Shift + 2
Machine Zero Shift + 3
Relative Zero Shift+4

Tool Change Position  Shift +5
Program Start Point Shift + 6
Current Line Start Point  Shift + 7
Last Feed Hold Point Shift + 8
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Coordinate System Pull-Down Menu - The tool will move to the XYZA position
in program coordinates, machine coordinates, relative coordinates, or
incrementally from the current position of the tool, depending on the option you
select.

Rate Mode Pull-Down Menu - You can set the travel rate by selecting one of the
following:

Rapid - The machine tool moves at the maximum feedrate allowed by
your current maximum feedrate settings in the Feedrate/Ramping Setup
dialog box.

Feedrate - The machine tool moves at the feedrate you enter in one of the
feedrate text boxes.

Linear Feedrate Text Box - If Feedrate is selected in the Rate Mode pull-down
menu, any moves that involve linear axes only will be done at this feedrate.

Rotary Feedrate Text Box - If Feedrate is selected in the Rate Mode pull-down
menu, any moves that involve the A axis will be done at this feedrate.

Move Button - Executes the move.

Feed Hold Button - Stops execution of the move. Hitting any key on the
keyboard (except Shift or Ctrl) also stops the move.

Home Control Panel

The Home Control Panel provides controls to seek the limit switches and establish
the Machine Zero location.

GCd | Jog | Point |[:

Seek Home Feed Hold {Any Key)

Seek Home - Finds the home switch on up to four axes. To save time, it is
recommended that you first jog each axis near the home switch before homing.
Once Machine Zero (home) is set, the machine tool envelope is redefined.

If Machine Zero was already set before homing, FlashCut displays a dialog
showing the discrepancy between the previous Machine Zero and the new
Machine Zero just found. This provides a convenient way to check that no steps
were lost while cutting a part, within the accuracy limits of the home switch. The
home switches supplied as a FlashCut accessory have a repeatability of +/-0.001".
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The homing operation can be tailored several ways, to suit the particular machine
tool configuration (see “Machine Tool Settings” in the Initial Setup section of this
manual.)

Feed Hold Button - Stops the homing operation. Hitting any key on the keyboard
(except Shift or Ctrl) also stops the operation.

Auxiliary Control Panel

The Auxiliary Control Panel provides controls for turning on or off any auxiliary
devices, such a spindle or coolant pump. Controls are displayed for each output
line with a Description entered in the Output Lines Setup dialog box.

GCd | Jog | Point | Hame |[£

1 [Spindle on Off
2 [Mist Coolant on Off
3 [Flood Coolant on Off

On / Off Buttons - Turns the indicated output line on or off. For safety, FlashCut
displays a confirmation dialog when you turn on a device (click OK to proceed).

Note that you can operate the On / Off buttons using the keyboard as follows:
Ctrl + output line number turns ON the line

Alt + output line number turns OFF the line

Message Box

Displays the current status of the Signal Generator and program. When the
Signal Generator is online, the Message Box and the Offline/Online indicator
are Red.

Offline / Online
File successfully processed Offline Indicator
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Program Listing Box

The Program Listing box displays the current G-Code program and highlights
the current line. You can use the scroll bar to view the entire program.

(Tse 174" End Mill) ; = Current Line

FO0 ¥.375 ¥.567
0l Z-.15 Fz.0 Program Listing
oo Z.5

00 =0 ¥.45

0l 2-.15 F4.0

Ol =0 ¥.25 j

Program Listing - A listing of the current G-Code program.

Current Line - The line currently being executed, or about to be executed by
FlashCut.

To improve system performance, the Program Listing Box can be configured to
display the current line of G-Code only, or to disappear completely while a G-
Code file is running (see “System Settings” in the Initial Setup section of this
manual).

Note that you can open the Editor dialog box by double-clicking the Program
Listing Box.
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Section 3. Initial Setup

This section describes how to set up FlashCut for use with your machine tool. It’s
very important that the software and hardware are set up properly. Incorrect setup
may cause the machine tool to behave in a potentially dangerous manner. Please
read through this section carefully to gain a thorough understanding of how
FlashCut controls your machine.

Windows Setup

Since FlashCut is a real time control program, it must have full control of the
operating system while running. It is very important that you do the following
before running FlashCut:

Disable all screen savers and power management programs.

Make sure there are no background programs running such as back-up
software and calendar reminders.

Make sure no other programs are open.

> To Disable the Screen Saver
Windows 95, 98 or NT
Choose Settings, then Control Panel from the Start Menu.
Double-click the Display icon.
Select the Screen Saver tab.
Select “(None)” from the Screen Saver pull-down menu.

Choose the Apply button.

o g~ w D

Choose OK to exit.

Windows 3.1

Double-click the Control Panel icon in the Main program group.
Double-click the Desktop icon.

Select “(None)” from the Screen Saver Name pull-down menu.

A w0 npoe

Choose OK to exit.

Software Setup

The Setup File

All software settings are stored in a “setup” file, which by default has a “.STP”
extension. Before you start, you’ll need to open the appropriate setup file for your
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machine tool. Choose Open Setup from the File menu and select the appropriate
setup file. Some setup files are supplied for various mills and lathes. If a setup
file is not available for your machine, select FLASHXXX.STP, where “XXX” is
the current software version (e.g. “FLASH141.STP” for version 1.41). You can
configure the setup parameters in this file for your machine tool.

Once you’ve opened a setup file, choose Save Setup As and follow the dialog
boxes to save the setup file under a new name or directory. This lets you go back
to the original setup file if necessary. Using this method you can create unique
setup files for any number of machine tools.

For machines that operate in more than one mode, such as combination mill-lathe
machines, you’ll load a separate setup file for each mode of operation.

The last setup file used will be loaded automatically the next time you run
FlashCut.

System Settings

> To set the System Settings

1. Choose System Options from the Setup menu. The System Options dialog
box will appear.

Commumications Machine Toal
seral Por: | EECKE - | Maching Type: [~ v Pk
=5 fxix
Baud Rate: | 5400 - Lathe Display | _| ——
Buffer Times [1 7 fsac) gth Axis Type: [~ay | F A Axis
General [Dekay ! Updane
Sigmal Generater; |4014 (oputs MO = Snart Coenrd
H | I.I |I .I J n-l.r wm
Disphay Umits: |Engl<h ok - [sac) [sac)
G-CodePaint |1 11 X0
-Code File Extersion: ||' L
Jng F 100 Fl?il:l
G Cade Filber: |l:-l ode Files [* FED) j
Gl [nieg | avy: |I'|rr;|1|-'|l sty B ﬂ Aibvance
[+ furtomatic File DraseChack Timimg Factor: |
| CK Cancel I

2. Serial Port - The serial port your computer will use to communicate with
the Signal Generator. Typically, this can be COM1, COM 2, COM 3, or
COM 4 depending on how many serial ports and serial devices you have,
such as a modem.

3. Baud Rate - The speed at which FlashCut communicates across the serial
port with the Signal Generator. It is measured in bits per second. This is
typically set at 38,400. For older PC’s exhibiting serial communications
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10.

problems, set this to a lower speed. For most applications, FlashCut will
perform the same at baud rates of 19,200, 38,400 and 57,600. If you
change this setting, you must reset the baud rate on the Signal Generator
by going Offline and Online from the Controller menu. If there are
communication problems, you must turn the Signal Generator off and on
before going back online.

Buffer Time - Used to prevent system events (such as screen updates)
from affecting motor movement on the machine tool. The larger the
Buffer Time, the less effect system events have on motor movement. The
smaller the Buffer Time, the more responsive the machine tool is to mouse
clicks and keyboard commands. In most cases, the lag-time between the
PC and the motor movement is imperceptible. The value can range from
0.01 to 1.0 seconds. Slower computers may require a higher value.

Signal Generator - Indicates how the limit switches are wired. Choose
401A if the limit switches are wired normally closed. Choose 401 if the
limit switches are be wired normally open. All limit switch kits supplied
by FlashCut are wired normally closed.

Display Units - Specifies units (English or Metric) that all screens will
display, and the units assumed by default for all G-Code files. If a G-
Code file uses units different from this setting, the G20 or G21 command
must be included at the top of the G-Code file (see the System
Programming section for details).

G-Code File Extension - Sets the file extension used when opening G-
Code files. If you normally open files made by the FlashCut DXF import
or files you’ve written in the FlashCut editor, set this to “FGC”. If you
normally open files made by another CAM program, enter its standard G-
Code file extension (such as “NC”).

G-Code Filter - Sets the filter used when opening G-Code files. Select
“All Files” if you normally open files with a variety of extensions. Select
“G-Code Files” if you normally use files with the G-Code File Extension
described above.

G-Code Display - Affects how the software displays the Program Listing
Box when running a G-Code file in continuous mode. When running G-
code files with many short moves, or when continuous contouring is
turned on, the FlashCut software runs faster if you select “Current G-Code
Line,” and runs fastest if you select “None”.

Automatic File Draw/Check - Determines whether FlashCut redraws and
rechecks a G-Code file each time you take action that affects processing of
the file (such as resetting Program coordinates). If you uncheck this
checkbox, FlashCut will not redraw and recheck the G-Code file
automatically. You will need to reset the file manually just before running
the file (using the Reset button on the G-Code Control Panel).
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11. Machine Type - Configures the software for Mill or Lathe mode. Mill
mode may be used for any XY or XYZ table including routers, plasma
cutters, and so on.

12. X, Y, Z, A Axes - Sets the axes in use on your machine tool. Check the
appropriate check boxes.

13. Lathe Display - Sets the orientation of the X+ direction in the Toolpath
View Port. This setting lets you match the display in the Toolpath View
Port to the actual direction of movement of the tool (for lathes only).

14. 4™ Axis Type - Sets the 4™ axis as either linear or rotary. In FlashCut, a
rotary 4™ axis is assigned letter ‘A’, while a linear 4" axis is assigned the
letter “W’. This manual will always refer to the 4™ axis as the ‘A’ axis,
but the “W’ alternative is always assumed.

15. Start Delay - Allows the button graphics to fully update after the Start,
Move or Axis Jog Buttons are selected, and before the machine tool
begins moving. There are separate values for Jog moves and G-Code or
Point moves. Slower computers may require a higher value.

16. Coordinate Update - Determines how often the coordinates are updated in
the Tool Position Box while the tool is moving. There are separate values
for Jog moves and G-Code or Point moves. Higher values may increase
performance on slower computers. Note that coordinates are always
updated at the end of every move.

17. Timing Factor - Sets the precision for timing on interpolated moves. The
higher the number, the greater the precision and the lower the system’s top
speed. For digital servo drivers, set this value to 2. For stepper drivers,
set this value between 3 and 8.

Motor Signal Settings

FlashCut provides four signals for motor drivers: step, direction, park and enable.
Different manufacturers have different requirements for the polarity and timing of
these signals. FlashCut provides the flexibility to tailor the motor signals to run
most drivers.

» To set the Motor Signal Settings

1. Choose Motor Signals from the Setup menu. The Motor Signal Setup
dialog box will appear.
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2. Motor Line - Sets the Signal Generator channel used for the axis. This
setting lets you map any axis letter to any channel in the Signal Generator.
This is particularly useful when the axes on a machine tool require
different axis letters depending on the mode of operation (e.g. combination
mill-lathe machines).

3. Motor Polarity - Sets the direction of rotation for the motor. Depending
on how a motor is wired, the same signal from the motor driver can turn it
clockwise or counter clockwise. Use the jog buttons to make sure that a
positive move in each axis on the screen corresponds to a positive move in
each axis on the machine tool. Note that the direction of movement is
defined as the direction of the tool relative to the workpiece. For example,
on a typical milling machine, a positive X move (tool movement to the
right) requires table movement to the left. If any direction is incorrect,
change the Motor Polarity from Positive to Negative (or vice-versa) to
reverse the correspondence between the software and machine tool.

4. Step Pulse - Sets the polarity of the step signal. Choose High or Low
based the diagram below.

+5V
oV
Low Step Pulse
_———High Step Pulse
— g P +5V
oV

Step Pulse Width

5. Step Pulse Width - Sets the duration of the step pulse in microseconds.

6. Enable Signal - Sets the polarity of the enable signal. Choose High if the
motor driver is enabled by a high signal, or Low if the motor driver is
enabled by a low signal.

7. Park Signal - Sets the polarity of the park signal. Choose High if a high
signal to the park (low power) line puts the driver into a reduced power
mode. Choose Low if the opposite is true. Note that most motor drivers
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do not have a separate line to control the power level. In this case the
setting isn’t applicable.

8. Dynamic Enable Line - Sets the behavior of the enable line. When
checked, the enable line turns on when any axis is in motion, and turns off
when all axes are idle.

The recommended motor signal settings for FlashCut CNC Motor Driver Boxes

are:
Motor Driver Type Stepper Servo
Step Pulse Low Low
Step Pulse Width 3 4
Enable Signal Low High
Park Signal Not Used (Low or High) | Not Used (Low or High)
E_ynamic Enable Unchecked Checked
ine

Machine Tool Settings

» To set the Machine Tool Settings

1. Choose Machine Tool from the Setup menu. The Machine Tool Setup
dialog box will appear.
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10.

11.

12.

13.

Step Mode - The number of micro steps between each full motor step.
Note that this is a characteristic of the motor driver and cannot be changed
without servicing the driver. Enter “1” for full-step, “2” for half-step, “8”
for eighth-step, and so on.

Motor Resolution - The number of full motor steps for one revolution of
the motor. For example, a 1.8° stepper motor has 200 full steps per
revolution, a 0.9° stepper motor has 400 full steps per revolution, and so
on. This number is a characteristic of the stepper motor and is
independent of the motor driver or the Step Mode.

Gear Ratio - The ratio of the number of stepper motor revolutions to
drive screw revolutions due to any gears or pulleys between them. For
direct drive, enter 1 in this box.

Screw Thread - The number of turns per unit length of the helical drive
screw for each axis. For example, a single threaded, 0.05” pitch screw
would have 20 turns per inch. For other types of drive mechanisms, enter
the number of motor or pulley turns per unit length traveled by the axis.

Tool Positioning Resolution - The length of axis movement per motor
step), automatically calculated from the Step Mode, Motor Resolution,
Gear Ratio and Screw Thread.

Axis Length - Sets the length of travel of each axis of your machine tool.
You may want to define the axis length slightly smaller than the values
published by the machine tool manufacturer. This will leave some room
for error.

Home End - The end of the axis at Machine Zero (Home).

Home Order - The axis order for the homing operation. For safety, set the
order so the initial homing move retracts the cutting tool away from the
workpiece.

Home Axis - Determines whether or not an axis is included in the homing
operation.

Home Switch Offset - The distance each axis backs away from the home
switch after the switch is tripped during homing.

Point Move Linear Interpolate - Determines if the motion for the axis will
be included in the interpolated move for a Point move or G28/G29
command (see “Point Control Panel” in the Main Screen Features section
of this manual).

Backlash - Sets the amount of backlash for each axis. See the “Setting Up ]
Backlash(” section below for more information.

Comp - Determines whether or not FlashCut will use backlash
compensation for all direction changes. Leave this check box unchecked
for now. It’s discussed in the “Betting Up Backlash{ section below.
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14. Tool Change Position - The position to which FlashCut moves the
machine tool when processing a G28 command in a G-Code program.
You must specify these values in Machine Coordinates. Machine Zero is
the most common choice for this position.

Feedrate and Ramping Settings

Every machine tool will vary as to how fast it can move each axis without losing
steps. Losing steps means that even though the stepper motor gets the signal to
move a step, it isn’t able to move the step, and accuracy is lost. The usual cause
is insufficient torque at a given motor RPM. Since most stepper motors are open
loop systems, there is no way of telling when a step is lost without physically
measuring the movement of the axis and comparing that to the amount it should
have moved. However, when not “over torqued”, a stepper motor is very reliable
and accurate. For that reason, we highly recommend finding the maximum rates
at which steps are not lost, both with and without ramping, and then limiting the
maximum rates for each axis to about 70% of those values. Due to variations in
the drive mechanism for each axis, make sure you do the following tests in all
directions, and at several positions along each axis.

» To Set the Maximum Unramped Feedrates

1. Choose Feedrate/Ramping from the Setup menu. The Feedrate/Ramping
Setup dialog box will appear.
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2. Enter 499 for the X axis Max Unramped Feedrate, and 500 for the
Maximum Feedrate, then choose OK.

3. Choose the Point button in the Control Selection Box. Select Any Point in
the Point list and Incremental from the Coordinate System pull-down



FlashCut CNC  Section 3 Initial Setup 33

menu. Enter 1.0 in the X text box. Choose Feedrate from the Rate Mode
pull-down menu and enter a relatively slow feedrate (such as 5) in the
Linear Feedrate text box. Make sure you have room to move the X axis 1
inch, then choose Move.

If the motor slips, repeat this process with a slower feedrate. If the motor
doesn’t slip, try a faster feedrate. Note that slight slippage can be detected
by reading the values on the table feed hand-wheel or using a dial
indicator.

Repeat this process until you find the highest feedrate that doesn’t cause
motor slippage.

Now run the entire length of the X axis in both directions to make sure
there is no slippage at any point on the entire axis.

Choose Feedrate/Ramping from the Setup menu.

Enter 70% of the value you found in the Max Unramped Feedrate text box
for the X axis, then choose OK.

Repeat this process for all axes.

To Set the Maximum Feedrates

After finding the maximum unramped feedrates, you’re ready to find the
maximum feedrates achievable with ramping.

1.

Choose Feedrate/Ramping from the Setup menu. The Feedrate/Ramping
Setup dialog box will appear.

Enter 5000 full steps/sec/sec in the Ramping Rate text box for the X axis.
(This is an average ramping rate.)

Leave the Max Unramped Feedrates at the values you found earlier.
Leave the Maximum Feedrates at the very high number (500 in/min) and
choose OK.

Choose the Point button on the Control Selection Box. Select Any Point
in the Point list and Incremental from the Coordinate System pull-down
menu. Enter 1.0 in the X text box. Choose Feedrate from the Rate Mode
pull-down menu and enter a feedrate that is double the Max Unramped
Feedrate for the X axis. Make sure you have room to move the X axis 1
inch, then choose Move.

If the motor slips, repeat this process with a slower feedrate. If the motor
doesn’t slip, try a faster feedrate. Note that slight slippage can be detected
by reading the values on the table feed hand-wheel or using a dial
indicator.

Repeat this process until you find the highest feedrate that doesn’t cause
motor slippage.

Now run the entire length of the X axis in both directions to make sure
there is no slippage at any point on the entire axis.
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8. Choose Feedrate/Ramping from the Setup Menu.

9. Enter 70% of the highest no-slip feedrate you found in the X axis
Maximum Feedrate text box.

10. Repeat this process for all axes.

To Set the Ramping Rate

Ramping Rates typically range from 1000 to 100000 full steps/sec/sec.
Slower ramping rates require more time to ramp up to the maximum feedrate
and to ramp down to a stop. This may become a potentially dangerous
situation when using the Feed Hold button or jogging since the machine will
take longer to come to a complete stop. The goal is to choose a fast ramping
rate that will start and stop the tool responsively without losing steps. Fast
ramping rates can also allow acceleration past resonant speeds of a stepper
motor.

1. Choose Feedrate/Ramping from the Setup menu. The Feedrate/Ramping
Setup dialog box will appear.

2. Enter 5000 full steps/sec/sec in the Ramping Rate text box for the X axis.
(This is an average ramping rate.)

3. Leave the Max Unramped Feedrates and Maximum Feedrates at the values
you found earlier and choose OK.

4. Choose the Point button on the Control Selection Box. Select Any Point
in the Point list and Incremental from the Coordinate System pull-down
menu. Enter 1.0 in the X text box. Choose Rapid from the Rate Mode
pull-down menu. Make sure you have room to move the X axis 1 inch,
then choose Move. If the table doesn’t reach a continuous speed before
ramping down to a stop, there isn’t enough room to fully ramp up and
down, and you should increase the length of the move.

5. If the motor slips, repeat this process with a lower Ramping Rate. If the
motor doesn’t slip, try a higher Ramping Rate. Note that slight slippage
can be detected by reading the values on the table feed hand-wheel or
using a dial indicator.

6. Repeat the above steps until you determine an optimal Ramping Rate for
the X axis.

7. Choose Feedrate/Ramping from the Setup menu.

8. Enter 70% of the highest no-slip ramping rate you found in the X axis
Ramping Rate text box.

9. Repeat this process for all axes.

10. Note that once the optimal ramping rate is determined for each axis, you
may want to re-test the Maximum Feedrates to see if they can be set any
higher.
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> To Set the Direction Change Delay

The direction change delay is a brief pause that occurs when a motor changes
direction. It gives the stepper motor time to settle and come to a complete rest
before moving in the opposite direction. Note that the direction change delay
is not used when a motor changes direction during circular interpolation or
during a continuous contouring motion.

1.

Write a G-Code file that goes back and forth on a given axis at the
maximum unramped feedrate. For example, if the maximum unramped
feedrate were 8:

G01 X2 F8
X0
X2
X0
Set the Direction Change Delay to 0.1 seconds for the given axis.

Run the program and notice if the motor loses steps. If so, increase the
Direction Change Delay. Otherwise decrease the value.

Repeat the above process until you reach a reasonable delay time that
eliminates any motor slippage. Note that this number is typically between
0.0 and 0.1 seconds. If you do not see any slippage at a delay of 0
seconds, it is recommended you enter at least 0.01 seconds.

Repeat the above process for all axes.

» To Set the Continuous Contouring Feedrate Tolerance

1.
2.

Choose Feedrate/Ramping from the Setup menu.

For each axis, enter the Maximum Unramped Feedrate value as a starting
point. Refining this setting is explained later in this section.

» To Set the Jog Rates

1.
2.

Choose Feedrate/Ramping from the Setup menu.

Fill in the Slow, Medium and Fast Linear Jog Rates (and the
corresponding Rotary Jog Rates if your machine tool includes a rotary
axis). Choose a Slow Jog Rate that will allow fine positioning of the
machine tool (typically about 2-5 in/min). Choose a Fast Jog Rate that
will move the tool quickly, yet allow you to remain in complete control
without creating a dangerous situation. Note that the machine tool will not
jog any faster than the Maximum Feedrate for each axis.
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» To Set the Maximum Arc Feedrate

Due to the computations involved during circular interpolation, an arc cannot
be executed as fast as a line. For this reason, there is a user-configurable
limitation for the maximum arc feedrate.

1. Write a G-Code program that moves in a circle at the Maximum Feedrate.
For example, if the Maximum Feedrate were 100:

GO0 X2 Y2
G02 X2Y211J1 F100

2. Run the program and notice if either of the motors loses steps. If so,
decrease the feedrate in the program.

3. Repeat the above process until neither motor loses any steps. Then enter
the final feedrate from the program into the Maximum Arc Feedrate text
box. If there was no loss of steps when the Maximum Feedrate was used,
enter the Maximum Feedrate into the text box.

To Set the Point Feedrates - Linear and Rotary

The value entered in the Pt. Feedrate - Linear and Pt. Feedrate - Rotary text
boxes will appear in the Linear Feedrate and Rotary Feedrate text boxes on
the Point Control Panel, whenever you start the FlashCut program. Enter the
feedrates you most commonly use for Point moves. A good starting point is
the medium jog rate.

To Set the Continuous Contouring On Check Box

Continuous contouring (also called “Look-ahead”) is a high performance
operating mode that lets FlashCut run G-code files smoother and faster. The
advantages of using continuous contouring are:

1. Smooth transitions from one G-code line to the next if the two moves are
in line with one another. There is no ramp down period and subsequent
ramp up period. This minimizes witness marks, burning, melting and
other quality problems sometimes encountered in machining. It also
provides smooth, high speed motion for any other control application that
requires it.

2. High speed machining of point-to-point type G-Code files (composed of
many short moves), used in complex 2D profiling and 3D surfacing.
These G-Codes files can be executed much faster with continuous
contouring turned on.
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In FlashCut, the differences between continuous contouring turned on and off
are as follows:

Continuous Contouring Off

FlashCut handles all moves individually, independent of the prior and
subsequent moves.

The feedrate override controls on the G-Code Control Panel are always
available.

You can choose between Step and Continuous modes (radio buttons on the
G-Code Control Panel).

Continuous Contouring On

FlashCut handles all moves as segments of smooth motions. A smooth
motion may span hundreds or thousands of G-code lines (there is no
limitation).

The feedrate override controls are not available while a G-Code file run is
in progress.

Step mode is not available.

To determine if two moves are lined up enough to allow a smooth transition
without ramping, FlashCut calculates the speed of each motor before and after
the transition, and compares that to the setting for Continuous Contouring
Feedrate Tolerance. If the difference in speeds for each motor is less than the
tolerance, FlashCut executes the two moves as part of the same smooth
motion. Otherwise, FlashCut ramps down to end one motion and ramps up to
begin another.

Any command that breaks the continuity of motion causes the machine tool to
ramp down to a stop (such as any M code to control an auxiliary device, a
G04 command for dwell, and so on).

A typical default setting for the Continuous Contouring Feedrate Tolerance is
the Maximum Unramped Feedrate value. The higher you set the tolerance,
the smoother a G-Code file will be executed (i.e., more moves will be linked
together into smooth motions). If the values are set too high, loss of steps
(stepper motor drivers) or servo errors (digital servo drivers) can occur. The
best way to find an optimal setting is through trial and error. Incrementally
raise the values and run demanding test files, checking for lost steps or servo
errors.

Since Step mode and the feedrate override controls aren’t available when
continuous contouring is turned on, it’s sometimes helpful to run a few lines
of a new program with continuous contouring turned off, to allow adjustment
of the feedrate override setting. Note that these controls will be made
available in continuous contouring mode in a future upgrade to FlashCut.
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Setting Up Backlash Compensation

CNC control works best if there is little or no backlash on the machine tool.
However, if your machine doesn’t have a zero-backlash drive mechanism (such as
ball screws or anti-backlash nuts), FlashCut can compensate for the backlash.

» To Set Backlash

1. Choose Machine Tool from the Setup menu. The Machine Tool Setup
dialog box will appear.

2. Make sure the Comp checkbox is unchecked, then choose OK.
3. Choose the Jog button on the Control Selection Box.

4. Drive the X axis in either direction at least 0.25” (to take out any backlash
in that direction).

5. Zero the Relative coordinates by choosing the Zero button next to the
Relative label.

6. Choose the Single Step radio button. Jog the axis step by step in the
opposite direction until you detect table movement (using a dial indicator).

7. The Relative coordinate X axis value is the amount of X axis backlash on
your machine tool.

8. Write down this number and repeat the above process at different places
along the X axis.

9. Choose Machine Tool from the Setup menu. The Machine Tool Setup
dialog box will appear.

10. Record the average of all backlash values in the X axis Backlash text box.
If you have no backlash on an axis, or if you don’t want backlash
compensation on an axis, enter zero.

11. Repeat the above steps for each axis. When you’re finished, select the
Comp checkbox and make sure there is a check in it.

Tooling Settings

FlashCut provides for a tool library of up to 100 tools. Each tool has an
associated tool number, description and length offset. The length offset is used
when tool length compensation (G43 or G44) is used in a G-Code program.

» To Set Up the Tool Library

1. Choose Tooling from the Setup menu. The Tooling Setup dialog box will
appear.
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2. Enter the tool description for each tool next to the appropriate tool
number. The program will use this description when referring to a given

tool.

3. Enter the length of the tool relative to a common reference point. For
example, if there is a locating feature on a tool holder that can be used to
maintain a repeatable location between the tool holder and the spindle,
enter the axial distance between the tip of the tool and the tool holder’s
locating feature. Note that this method assumes each tool has its own tool

holder.

Locating
Surfaces on
Tool Holders
Tool #1
Length Tool #2
Offset Length
Offset
v
v

4. Repeat the above for each tool in your library.
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Input Line Settings
FlashCut can read up to 8 input lines wired to switches with various functions:

* Limit/home sensing

» General safety (such as a door switch on a safety enclosure or a servo error
line)

» Control (such as a switch that detects completed motion of an air cylinder
or other device).

You can use each of the 8 input lines however you choose, but all must be wired
the same, either all normally open or all normally closed. If you’re using the
Model 401A Signal Generator, you may choose between normally open (N.O.)
and normally closed (N.C.) wiring. If you’re using the Model 401 Signal
Generator, you must wire all input lines normally open. Make sure the Signal
Generator setting in the System Options dialog box matches your wiring scheme.

Please see the FlashCut CNC Hardware Guide for more hardware details,
including the pin layout of the input line connector.

When FlashCut detects a tripped limit or safety switch, it immediately stops all
tool movement without ramping. The accuracy of the tool position will most
likely be lost at that point.

If a limit switch has been tripped, FlashCut will only allow you to jog away from
the switch that was tripped. Once you move the table off the limit switch, normal
operation will resume.

If a safety switch is tripped, FlashCut will not allow any machine movement until
you clear the switch.

For information on how FlashCut handles control switches, please see “M100,
M101 Wait for Input Line” in the System Programming section of this manual.
» To Configure the Input Lines

1. Choose Input Lines from the Setup menu. The Input Lines Setup dialog
box will appear.
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2. For input line 1, choose the appropriate option from the Switch Function
pull-down menu. For example, if the line is wired to a limit switch on the
negative end of the X axis, choose X-. If the line is wired to a general-
purpose safety switch (including a servo error line), choose Safety and
enter a Description. If the line is wired to a switch used for control
purposes, choose Control and enter a Description (see “M100 / M101” in
the System Programming section for more details on use of control
switches). If the line is not used, choose Unused.

3. Repeat for all 8 input lines.

Output Line Settings

FlashCut can control up to 8 output lines to activate devices such as a spindle or

coolant pump. You can control any or all of the output lines with user defined M
codes. Please see the FlashCut CNC Hardware Guide for more hardware details
including the pin layout of the output line connector.

» To Configure the Output Lines

1. Choose Output Lines from the Setup menu. The Output Lines Setup
dialog box will appear.
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In the Description text boxes, type descriptions for each device connected
to the output lines. Any line with a Description entered will appear on the
Auxiliary Control Panel.

To define an M-code to control output lines

1.

In the M Code text box type the number for the M-code that you want to
define.

In the Description text box type a phrase that best describes the action
taken when this M-code is executed.

In the Output Line Action pull-down menus, choose the action for each
line upon execution of the M-code. The choices are On, Off, or *-*, where
‘-* indicates the state of the line remains unchanged.

Choose Before or After from the Before/After Move pull-down menu. If
you choose Before and there is a machine tool move command on the
same program line as the M-Code, FlashCut will execute the M-code
before the move. If you chose After, FlashCut will execute the M-code
after the move.

In the Delay text box, enter the amount of delay between execution of the
M-Code and execution of the next G-Code command. For example, if the
spindle motor takes about 3 seconds to reach full speed, this value should
be at least 3. For safety reasons, the maximum value for this delay is 5
seconds.
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G and M Code Settings
FlashCut lets you customize handling of some G and M codes.

» To Configure G and M Code Handling

1. Choose G/M Codes from the Setup menu. The G/M Code Setup dialog
box will appear.
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2. lgnore G54 - Directs FlashCut to ignore the G54 command in a G-Code
program. If you select this option, make certain any G-Code program you
run does not rely on G54 to position the machine tool. FlashCut does not
currently support the G54 command.

3. Message on MO0 Program Pause - Directs FlashCut to display a message
dialog whenever it encounters an MOO command in a G-Code program. If
you uncheck this option, FlashCut will still pause processing of the G-
Code program on MO0, but will not display a message to the operator.

4. G73/G83 Retract Distance - Sets the ‘D’ distance for canned drilling
cycles. See “G73, G80, G81, G83, G98, G99 Canned Cycles” in the
System Programming section for details.

5. M100/M101 Debounce and Timeout - Sets the debounce and timeout
duration for the M100 and M101 commands. See “M2100, M101 Wait for
Input Line” in the System Programming section for details.

Message Settings

FlashCut lets you turn off some warning messages. This is a convenience feature
intended for experienced FlashCut users only. Please do not turn off any warning
messages until you’re very familiar with operation of the software and your
machine tool.
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» To Configure Warning Messages

1. Choose Messages from the Setup menu. The Message Setup dialog box
will appear.
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2. Reset Program - Directs FlashCut to display a warning message whenever
you choose Reset on the G-Code Control Panel.

3. Not Starting at Zero - Directs FlashCut to display a warning message
whenever you choose Start on the G-Code Control Panel, and the Program
coordinates have not been zeroed.

4. Zero Program Coordinates, Zero Machine Coordinates, Zero Relative
Coordinates - Directs FlashCut to display a warning message whenever
you choose the Zero button for the associated coordinate system.

Setting Machine Zero

FlashCut lets you set Machine Zero two ways: Using limit switches or using the
Zero button. Either method establishes the machine tool envelope, which
provides these benefits:

1. The software will always ramp down the machine tool to a complete stop at
the defined limits of the machine tool envelope.

2. The software checks each G-Code file before running to make sure the
toolpath fits completely within the machine tool envelope.

Its better to use limit switches since they provide these added benefits:

1. It’s much more convenient, since FlashCut can find Machine Zero
automatically.

2. You can establish Machine Zero at the same repeatable location anytime you
like (within the repeatability tolerance of the switch). A repeatable Machine
Zero lets you restart unfinished jobs, and reliably position the tool relative to
work-holding fixtures.

3. You can use the homing process to check for accuracy of the machine tool’s
position.
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» To Set Machine Zero Using Limit Switches

1.

Make sure you’ve correctly entered the homing-related setup parameters
described in the “Machine Tool Settings” and “Input Line Settings”
sections above.

Choose the Home button on the Control Selection Box.

Choose the Seek Home button. One axis at a time, FlashCut drives the
axis until it finds and backs off the switch. To stop the process, choose the
Feed Hold button, or hit any key on the keyboard besides Ctrl or Shift.

If Machine Zero was already set before homing, FlashCut displays a
dialog showing the discrepancy between the previous Machine Zero and
the new Machine Zero just found. Choose Yes if you want to use the new
Machine Zero just found, or No if you want to keep the existing Machine
Zero.

If you chose Yes, FlashCut zeros the Machine Coordinates and displays
the Machine Tool Envelope in the Toolpath View Port.

» To Set Machine Zero Using the Zero Button

1.

Make sure you’ve correctly entered the homing-related setup parameters
described in the “Machine Tool Settings” section above.

Choose the Jog button on the Control Selection Box.

Jog the tool to the home end of each axis (as defined in the Home End
column in the Machine Tool Setup dialog box). Move each axis to within
a short distance of its physical limit.

If this is the first time you’re setting Machine Zero on your machine, it
might be helpful to scratch a reference line or affix a vernier scale between
the two relative moving parts on each axis. This will help you find the
same home position again in the future.

Choose the Zero button next to the Machine label in the Tool Position
Box. When the confirmation dialog appears, choose Yes (see “Message
Settings” above for details on suppressing this dialog if desired).

If Machine Zero was already set, FlashCut displays a dialog showing the
discrepancy between the previous Machine Zero and the new Machine
Zero just set. Choose Yes if you want to use the new Machine Zero just
set, or No if you want to keep the existing Machine Zero.

If you chose Yes, FlashCut zeros the Machine Coordinates and displays
the Machine Tool Envelope in the Toolpath View Port.
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Section 4.

System Programming

FlashCut reads a subset of ANSI standard G-Code to control machine tool
movement. This section describes how to bring a G-Code file into FlashCut, the
G-Codes supported, and a brief explanation of their use.

There are three ways you can bring G-Code files into FlashCut:

» Open an existing G-Code file created by a CAM program, FlashCut or
any other source.

e Import a DXF file created by a CAD or drawing program.
*  Write a G-Code program directly in the FlashCut editor.

Opening a G-Code Program

» To open an existing program

1.

Choose Open G-Code from the File menu. The Open G-Code File dialog
box appears.

In the “List files of type” pull-down menu, choose the type of file you are
looking for. Existing FlashCut files will have an “.FGC” extension. If
you are unsure of the file type, choose “All Files (*.*).”

In the Drives pull-down menu choose the drive that contains the file.

In the Folders list box, double-click the name of the folder that contains
the file. Continue double-clicking subfolders until you open the subfolder
that contains the file.

In the box that lists files, double-click the file name, or click on the file
name and choose OK.

Importing a DXF File

FlashCut provides a very useful 2D DXF import feature. The DXF import
automatically arranges all lines and circles that have common endpoints into
features. The entire toolpath is then optimized to reduce total machining time for
the part. The DXF import assumes the part surface is at a Z program height of 0.0
and all geometry is to be treated as either holes or cutter paths with no offsets.

» Toimport a DXF file

1.

Choose Import DXF from the File menu. The Import DXF File dialog box
appears.

In the “List files of type” pull-down menu, choose the type of file you are
looking for. A DXEF file should have a “.DXF” extension.
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In the Drives pull-down menu choose the drive that contains the file.

In Folders list box, double-click the name of the folder that contains the
file. Continue double-clicking subfolders until you open the subfolder that
contains the file.

In the box that lists files, double-click the file name, or click on the file
name and choose OK.

The Save G-Code File dialog box appears asking you the name of the new
G-Code file created by the DXF import. By default, it will use the DXF
file name with an “.FGC” extension in the same drive and folder in which
the DXF file resides. If this is acceptable, choose OK.

To choose a different file name or folder

5.

Choose the drive you want from the Drives pull-down menu.
Click on the folder you want in the Folder box.

Type the file name in the File name box, or type the entire path in the File
name box.

Choose OK.
The Import Setup dialog box will appear.
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Fill in the values for each of the following fields:

Scale - A multiplication factor for the toolpath in the XY plane only. For
example, if you enter a 2 here, the toolpath generated will be double the
size of the original geometry defined in the DXF file. Note that the values
you enter for positioning the Z axis are unaffected by the scale factor.
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10.

11.

12.

13.

14.

15.

16.
17.
18.

19.
20.

Decimals - The number of decimal places to use for all coordinates. A
higher number can help eliminate extra backlash compensation moves
caused by rounding error.

Join Tolerance - If two drawing entities, such as two lines, are touching
end to end, FlashCut treats them as a single feature to machine without
lifting the tool. Due to rounding or drawing error, two entities that are
meant to be joined may not actually touch end to end. The DXF import
will automatically join any entities whose endpoints are less than the Join
Tolerance apart.

Line Numbers - Check this box if you want the DXF import to number all
of the G-Code lines in the program it creates.

Tool Up - The height (program coordinates) to which the tool will move
before rapid moves between two features.

Incremental Depth of Cut - The incremental depth for each milling pass.
For example if the final tool down is -0.2500” and the incremental depth
of cut is 0.0625” then four passes would be cut on each feature to get to
the final depth of cut. (-0.0625, -0.1250, -0.1875, -0.2500). If the final
tool down is -0.3000” and the incremental depth of cut is 0.0625” then
five passes would be cut on each feature to get to the final depth of cut (-
0.0625, -0.1250, -0.1875, -0.2500, -0.3000).

Final Tool Down (Milling) - The final depth (Program coordinates) to
which the tool will cut each feature.

Final Tool Down (Holes) - The final depth (Program coordinates) to
which the tool will cut each hole.

Program Zero Location - Determines where FlashCut will place Program
Zero relative to the coordinate system of the import file. There are two
options:

X, Y of Import File - You specify the X and Y location in the DXF file’s
coordinate system that FlashCut will place at Program Zero in the G-Code
file.

Lower Left of Toolpath - FlashCut sets Program Zero at the lower left
corner of the imaginary box that envelopes all geometry contained in the
DXF file.

XY Feedrate - The feedrate for cutting moves in the XY plane.

Plunge Feedrate - The feedrate for all downward Z axis moves.
Circles - Defines diameters for circles that will be drilled (at the center
point) instead of milled along the perimeter.

Choose OK.

FlashCut generates the G-Code file, displays it in the Program Listing

Box, and displays the toolpath in the Toolpath View Port.
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Using the Program Editor

FlashCut provides a simple editor for creating or modifying G-Code Programs.
You can also use your own editor such as WordPad (which comes standard with
Windows 95/98), Microsoft Word, and so on. If you use a different editor, make
sure you save the file as Text Only and use an “.FGC” extension in the file name.

» To open the editor

1. Choose Editor from the File menu, or double-click the Program Listing
Box. The editor dialog box will appear.

§ Edit UNTITLED.FGC
Eile

LUpdate Tool Path Exit

2. Type or edit your program in the scrolling text box. Refer to the “G and |
M Code Reference|’ section below to learn more about using G-Code.

» To edit a new program

1. Choose New Program from the editor’s File menu.

» To open an existing program

1. Choose Open G-Code from the editor’s File menu. The Open G-Code
File dialog box appears.
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2. Inthe “List files of type” pull-down menu, choose the type of file you are
looking for. Existing FlashCut files will have an “.FGC” extension. If
you are unsure of the file type, choose “All Files (*.*).”

3. In the Drives pull-down menu choose the drive that contains the file.

4. In Folders list box, double-click the name of the folder that contains the
file. Continue double-clicking subfolders until you open the subfolder that
contains the file.

5. In the box that lists files, double-click the file name, or click on the file
name and choose OK.
» To see your new toolpath updated in the Toolpath View Port without
leaving the editor
1. Choose Update Tool Path.
» To copy and paste text within the editor, or between the editor and other
programs
1. Use the standard Windows keyboard shortcuts as follows:
Copy Ctrl+ C
Paste Ctrl +V
» To save your program using the same file name
1. Choose Save G-Code from the editor’s File menu.

2. If you’re saving a new file, a Save G-Code File dialog box will appear.
Follow the directions “To save a new program...” below starting with step
2.

» To save a new program created by the editor, or to save an edited file
under a different file name
1. Choose Save G-Code As from the editor’s File menu.
2. Choose the drive you want from the Drives pull-down menu.
3. Click on the folder you want in the Folder box.
4

. Type the file name in the File name box, or type the entire path in the File
name box.

5. Choose OK.

» To close the editor

1. Choose Exit.
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G Codes Supported

GO0
GO01
G02
G03
G04
G1l7
G18
G19
G20
G21
G28
G29
G43
G44
G49
G52
G70
G71
G73
G80
G81
G83
G90
GI1
G98
G99

Rapid Tool Positioning

Linear Interpolated Feedrate Move
Clockwise Circular Feedrate Move
Counter Clockwise Circular Feedrate Move
Dwell

XY Plane Selection

XZ Plane Selection

YZ Plane Selection

Inch Units (same as G70)

Metric Units (same as G71)

Return to Reference Point

Return from Reference Point

Tool Length Compensation (Plus)

Tool Length Compensation (Minus)
Cancel Tool Length Compensation

Use Local Coordinate System

Inch Units (same as G20)

Metric Units (same as G21)

High Speed Peck Drilling Cycle
Cancel Canned Cycle

Drilling Cycle

Peck Drilling Cycle

Absolute Positioning Mode
Incremental Positioning Mode

Return to Initial Level (Canned Cycles)
Return to Rapid Level (Canned Cycles)
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M Codes Supported
MOO Program Pause

MO02 End of Program
MO03 Spindle On

MO05  Spindle Off

MO06 Tool Change
MO7  Mist Coolant On
MO8 Flood Coolant On
M09 Coolant Off

MXX Custom Programmable (See “{Output Line Settings|’ in the Software Setup|
section of this manual)

M30 End of Program (Reset)

M98  Subroutine Call

M99 Return From Subroutine

M100 Wait for Input Line (Normal State)
M101 Wait for Input Line (Tripped State)

Other Commands Supported
F Feedrate

) Comment

Key Programming Concepts

There are two basic programming concepts you should understand before learning
the G and M codes - Mode and Absolute vs. Incremental.

Mode

Most G-code commands supported by FlashCut are modal, meaning they put the
system into a particular mode of operation and need not be repeated on every
program line. A modal command stays in effect until another command changes
the mode. Related modal commands that affect one aspect of program execution
are called a mode group.

The following list shows the mode groups supported by FlashCut.
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Movement

GO0 Rapid Tool Positioning

GO01 Linear Interpolated Feedrate Move

G02 Clockwise Circular Feedrate Move

G03  Counter Clockwise Circular Feedrate Move

Circular Interpolation

G17
G18
G19

Units

G20
G21

XY Plane Selection
XZ Plane Selection
YZ Plane Selection

Inch Units (also G70)
Metric Units (also G71)

Tool Length Compensation

G43
G44
G49

Tool Length Compensation (Plus)
Tool Length Compensation (Minus)

Cancel Tool Length Compensation

Canned Cycles

G73
G80
G81
G83

High Speed Peck Drilling Cycle
Cancel Canned Cycle

Drilling Cycle

Peck Drilling Cycle

Canned Cycle Return

G98  Return to Initial Level

G99 Return to Rapid Level
Positioning

G90 Absolute Positioning Mode
G91 Incremental Positioning Mode

Independent Modal Commands

G52
F

Use Local Coordinate System
Feedrate
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Absolute vs. Incremental

All moves are either absolute or incremental. In an absolute move, the ending
point is defined relative to Program Zero. In an incremental move, the ending
point is defined relative to the current tool location. The G90/G91 commands tell
the system which of these two modes to use (described below).

While there will be cases where incremental programming is useful, generally you
should define your moves as absolute since it is a less error prone method of
programming. All of the examples in the following section use absolute
positioning unless otherwise noted.

G and M Code Reference

GO00 Rapid Tool Positioning

The GO0 command moves the tool to the designated coordinate at the rapid rate
using 3-axis linear interpolation. The rapid rate is calculated from the Maximum
Feedrates defined in the Feedrate/Ramping Setup dialog box.

Example:

G00 X1.0Y2.021.5 Moves the tool to Program coordinates
X=1.0, Y=2.0, Z=1.5 at the rapid rate

When using GO0, there are several things to keep in mind:

» While FlashCut supports machine tools with up to four axes, you may
specify at most three coordinates for a GOO move. If you need to
move all four axes, use two GOO commands.

* You do not need to specify three coordinates, only the ones for which
you want movement.

Example:

G00 X4.0Y3.0 Moves the tool to Program
coordinates X=4.0, Y=3.0, leaving
the Z position unchanged

e This is a modal command, meaning that all successive moves will be
treated as rapid moves until another modal move command (G01, G02
or G03) occurs.

Example:
G00 X1.0Y2.0Z71.5 Rapid Move
X4.0Y6.521.0 Rapid Move
G01 X3.0Y3.0Z14 Feedrate Move
X2.8Y1.4 20 Feedrate Move

» The interpretation of the coordinates depends on the G90/G91
command in effect.
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GO01 Linear Interpolated Feedrate Move

The GO1 command moves the tool to the designated Program coordinate at the
specified feedrate using 3-axis linear interpolation.

Example:

G01 X2.0Y1.0Z-1.5F2.0 Moves the tool to Program coordinates

X=2.0, Y=1.0, Z=-1.5 at a feedrate of 2.0
in/min

When using GO01, there are several things to keep in mind:

While FlashCut supports machine tools with up to four axes, you may
specify at most three coordinates for a GO1 move.

You do not need to specify three coordinates, only the ones for which
you want movement.

Example:

G01 X4.0 Y3.0F2.0 Moves the tool to Program
coordinates X=4.0, Y=3.0, leaving
the Z position unchanged

This is a modal command, meaning that all successive moves will be
treated as linear feedrate moves until another modal move command
(G00, G02 or G03) occurs.

The interpretation of the coordinates depends on the G90/G91
command in effect.

The F command is used to designate a feedrate. The feedrate set with
the F command is modal (stays in effect until another F command
occurs).

Example:

GO01 X4.0Y3.0Z1.0F7.0  Moves the tool to Program
coordinates X=4.0, Y=3.0, Z=1.0 at
a feedrate of 7.0 in/min

X2.0Y25 Moves the tool to Program
coordinates X=2.0 Y=2.5, leaving
the Z axis unchanged at Z=1.0 (the
feedrate remains 7.0 in/min)

For any move that includes the A (rotary) axis, the A axis always
controls the timing. The F parameter is interpreted as degrees/minute.

Example:
G01 X1 A90 F360

The A axis turns 90 degrees while the X axis moves 1 inch. The A
axis turns at exactly 360 degrees/minute. The timing for the X axis is
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based on the A axis motion and is not explicitly listed in the G-code
file.

Note that the F feedrate in use is always interpreted as degrees/minute
for any move that contains motion on the A axis. For all other moves,
it's interpreted as inches/minute (or mm/min). Therefore, you must be
very careful to reset F every time you switch between pure linear and
rotary-included moves.

G02 Clockwise Circular Feedrate Move

The G02 command moves the tool in a clockwise path from the starting point (the
current tool position) to the designated ending point in the currently selected plane
(see G17-G19). The I, J, and K parameters represent the relative X, Y, and Z
distances (respectively) from the starting point of the arc to the center point of the
arc.

Example:

G01 X1.0Y1.0F3.0 Moves the tool to Program coordinates
X=1.0, Y=1.0 at a feedrate of 3.0 in/min

G02 X3.0Y3.011.0J1.0 Moves the tool using clockwise circular
interpolation to Program coordinates X=3.0,
Y=3.0 with a center point of X=2.0, Y=2.0
at a feedrate of 3.0 in/min

/ 3,3 End

»Y 2,2 Center

1,1 Start
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When using G02, there are several things to keep in mind:

This is a modal command, meaning that all successive moves will be
treated as clockwise circular feedrate moves until another modal move
command (G00, GO1 or GO3) occurs.

The interpretation of the X, Y and Z coordinates depends on the
G90/G91 command in effect. The I, J and K values are unaffected by
G90/G91.

The tool will move at the current feedrate set by the last F command.

Only XY arcs can be cut when G17 is active, only XZ arcs can be cut
when G18 is active and only YZ arcs can be cut when G19 is active.
Arcs cannot be specified for the A or W axes.

The clockwise direction of rotation is as viewed from the positive end
of the unused axis (the axis not in the plane of motion). For example,
a G02 arc move in the XY plane is clockwise as viewed from the
positive end of the Z axis (i.e. from above). The following diagram
illustrates this behavior:

+Y

GO02 Clockwise GO02 Clockwise GO02 Clockwise

+ZA +ZA

I

> < >
+X +X +Y

GO03 Counter Clockwise Circular Feedrate Move

The G03 command is identical to the G02 command, but it moves the tool in a
counter clockwise arc instead of a clockwise arc.

Example:

G01 X2.0 Y1.0F8.0 Moves the tool to Program coordinates

X=2.0, Y=1.0 at a feedrate of 8.0 in/min

GO03 X0.0Y3.01-1.0J1.0  Moves the tool using counter clockwise

circular interpolation to the Program
coordinates X=0.0, Y=3.0 with a center
point of X=1.0, Y=2.0 at a feedrate of 8.0
in/min



FlashCut CNC Section 4 System Programming 59

2,1 Start

GO04 Dwell

The G04 command causes the program to dwell for a specified amount of time.
The command format is:

G04 Xn

where n is the number of seconds to wait. For safety reasons there is a maximum
time allowed for each dwell command.

Example:

G04 X1.5 Program pauses for 1.5 seconds before
moving on to the next line of G-Code

G17, G18, G19 Arc Plane Selection
These commands specify the plane used for circular interpolation as follows:

G17 XY plane
G18 XZplane
G19 YZplane

When using G17-G19, there are several things to keep in mind:

» Unless you explicitly use the G18 or G19 command, FlashCut assumes
G17 as the default.
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* The three commands are modal, i.e. one command remains in effect
until another in the set is used.

G20, G21 Inch Units and Metric Units

The G20 command indicates that all G-Code commands are in inch units.
FlashCut then assumes all distances are in inches and all feedrates are in
inches/minute. For compatibility reasons, FlashCut accepts G70 as equivalent to
G20.

The G21 command indicates that all G-Code commands are in metric units.
FlashCut then assumes all distances are in millimeters and all feedrates are in
millimeters/minute. For compatibility reasons, FlashCut accepts G71 as
equivalent to G21.

When using G20 or G21, there are several things to keep in mind:

» If you don’t use either command, FlashCut assumes all program values
are consistent with the Display Units setting in the System Options
dialog box.

* You may only use one of these two commands in any G-Code
program, so all values in a G-Code file must use the same unit system.

G28 Return to Reference Point

The G28 command moves the tool at the rapid rate to the Tool Change Position
defined in the Machine Tool Setup dialog box. This position is defined in
Machine Coordinates, so Machine Zero must be set for this command to be used.

The sequence of axis motions follows a general-purpose scheme that’s described
under “Point Control Panel” in the Main Screen Features section of this manual.

If you want the G28 command to move only some of the axes on your machine
tool, you can limit the movement to those axes by adding the parameters “X0”,
“Y07”, “Z0” or “A0” after the G28 command. Then, FlashCut moves only the
indicated axes to their Tool Change Position coordinates. A typical use is to only
raise the Z axis for a manual tool change (“G28 Z0”).

Example:
The Tool Change Position is defined as Machine Coordinate X=1, Y=1, Z=-1.

G01 X1.5Y25Z-3F10 Linear move to the Program coordinates
X=1.5,Y=25, Z=-3

G28 Z0 Rapid move in the Z axis only to Machine
coordinate Z=-1

G01 X1.5Y25Z-3F10 Linear move to the Program coordinates
X=1.5,Y=25, Z=-3
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G28

GO01 X1.5Y2.5Z-3F10

G28 X0 YO0 Z0

G29 Return from Reference Point

Rapid move in the Z axis to Machine
coordinate Z=-1 followed by a rapid move
in the XY plane to Machine coordinates
X=1,Y=1

Linear move to the Program coordinates
X=1.5,Y=25,27=-3

Rapid move in the Z axis to Machine
coordinate Z=-1 followed by a rapid move
in the XY plane to Machine coordinates
X=1, Y=1 (identical to the G28 command
with no parameters specified)

The G29 command moves the tool to the designated XY ZA coordinate at the

rapid rate.

The sequence of axis motions follows a general-purpose scheme that’s described
under “Point Control Panel” in the Main Screen Features section of this manual.

Example:

The Tool Change Position is defined as Machine Coordinate X=1, Y=1, Z=-1.

GO01 X1.5Y2.5Z-3F10

G28

G29 X2 Y3 Z-2

Linear move to the Program coordinates
X=1.5,Y=25,27=-3

Rapid move in the Z axis to Machine
coordinate Z=-1 followed by a rapid move
in the XY plane to Machine coordinates
X=1,Y=1

Rapid move in the XY plane to Program
coordinates X=2, Y=3 followed by a rapid
move in the Z axis to Program coordinate
Z=-2

When using G29, there are several things to keep in mind:

* You do not need to specify coordinates for all machine tool axes, only the
ones for which you want movement.

Example:
G29 X4.0 Y3.0

Moves the tool to Program
coordinates X=4.0, Y=3.0, leaving
the Z position unchanged

» The interpretation of the coordinates depends on the G90/G91 command in

effect.
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G43, G44, G49, M06 Tool Change and Tool Length Compensation
Commands

FlashCut supports tool changes and tool length compensation. Tool length
compensation lets FlashCut account for differences in tool lengths, so the G-Code
program can be created without regard to specific tool lengths (except for possible
interference problems).

THESE COMMANDS ARE NOT FOR THE NOVICE CNC USER. WHEN
NOT PROPERLY USED, TOOL LENGTH COMPENSATION CAN CRASH
THE MACHINE TOOL, CAUSING SERIOUS DAMAGE TO YOUR
WORKPIECE OR MACHINE TOOL.

When applying tool length compensation, FlashCut uses the Length Offsets
defined in the Tooling Setup dialog box. See “Tooling Settings” in the Initial
Setup section for more information on defining your tools.

For tool length compensation to work properly, FlashCut must know what tool is
in use at all times, including the tool that’s loaded when you start running a G-
Code file. Therefore, before you run a G-Code file that uses tool length
compensation, you must first choose your starting tool from the Current Tool
pull-down menu on the main screen.

To indicate tool changes in the G-Code file, use the M06 command as follows:
MO6 Tn

where n is the tool number in the Tooling Setup dialog box.

Example:

MO6 T3 Pauses program, displays dialog informing
operator to change to tool number 3

Note: For compatibility reasons, the T command can be used on any line prior to
the M06 command,; it does not need to be on the same line as M06.

Once the M06 command has set the current tool, the G43 command applies the
proper offset to account for the current tool’s length as follows:

G43 Hn
where n is the tool number for the current tool.

The G43 command tells FlashCut to shift all subsequent Z axis moves away from
the workpiece (in the positive Z direction) by an offset amount. The offset
amount is equal to the difference in lengths between the current tool when the
G43 command is executed and the previous tool. FlashCut uses the Length Offset
values in the Tooling Setup dialog box to calculate the difference in lengths
between two tools.
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Example:

G43 H3 Shifts all subsequent Z axis moves away
from the workpiece (in the positive Z
direction) by the difference in lengths
between tool number 3 and the previous tool

The G44 command is identical to the G43 command, except that it shifts all Z
axis moves in the direction opposite from G43. Unless you are an experienced
CNC programmer and know how to use G44 correctly, G43 is the preferred
command.

The G49 command cancels tool length compensation. It removes any offset that
FlashCut has applied since the G-Code program began running.

When using tool length compensation there are several important things to keep in
mind:

* You must predefine all tools and tool lengths in the Tooling Setup
dialog box.

e It’s good practice to include an M06 tool change and a G43
compensation command for the first tool used, near the beginning of
the G-Code program.

» FlashCut automatically cancels tool offset when it finishes processing
a G-Code file, or during any operation that ends the current run of the
G-Code file (such as resetting the program, opening a new program,
and so on.) TO AVOID CRASHING THE MACHINE TOOL, IT IS
VERY IMPORTANT THAT YOU REMOVE THE CURRENT
TOOL FROM THE SPINDLE WHENEVER FLASHCUT CNC
CANCELS TOOL OFFSET.

* The G43, G44 and G49 commands are modal, so the current tool offset
remains active until FlashCut executes another tool offset command,
or until FlashCut cancels tool offset as described above. Note that you
may only use one type of tool length compensation (G43 or G44) in a
G-Code program.

» The M06 command does not move the machine tool to the Tool
Change Position. This is done using the G28 command described
above. It’s good practice to place the G28 command in the line
directly preceding the M06 command.

e It’s good practice to use the G43 command in the line directly
following the M06 command.

The following example illustrates proper use of the tool change and tool length
compensation commands.

Example:

The tool library is shown below.
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¥ Setup Tooling E

~ Tool Definitions

Length Offset
Description {inches)
1/4" Ball Endmill 4 Flute 1.6000 -
172" EndMill 22500 |
1/8 Ball Endmill Tik coated 1.0000
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0.0000
0.0000
0.0000
0.0000
0.0000
0.0000
0.0000 Ok
0.0000
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0.0000 -

Cancel
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The first tool used in the program is tool #1, so it is selected in the Current Tool
pull-down menu on the main screen. The tool change position is defined as
Machine Coordinates X=2, Y=2, Z=0. Tool #1 is loaded in the machine tool.
Program zero has been set using tool #1. Program zero is set at Machine
Coordinates X=0, Y=0, Z=-4. The machine tool is moved to Program
Coordinates X=0, Y=0, Z=1 before the G-Code file is run.

MO03 Turns on the spindle

G00 Z.25 Move the Z axis down to Program
coordinates X=0, Y=0, Z=0.25, Machine
coordinates X=0, Y=0, Z=-3.75

G01 Z-1.0F10 Move the Z axis down to Program
coordinates X=0, Y=0, Z=-1, Machine
coordinates X=0, Y=0, Z=-5

G00 Z.25 Move the Z axis up to Program coordinates
X=0, Y=0, Z=0.25, Machine coordinates
X=0, Y=0, Z=-3.75

G28 Move the Z axis up and the X and Y axes
across to the Tool Change Position, Program
coordinates X=2, Y=2, Z=4, Machine
coordinates X=2, Y=2, Z=0

MO06 T2 Change the tool to Tool #2 (all coordinates
remain unchanged, and the spindle is turned
off)
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G43 H2 Apply the tool length compensation for tool
#2. The offset amount is 0.750 (2.250-
1.500). The tool does not move. However,
the Program coordinates change to X=2,
Y=2, Z=3.25. The Machine coordinates
remain unchanged at X=2, Y=2, Z=0

MO03 Turns on the spindle

G29 X1Y1Z0.25 Move the X and Y axes across and the Z
axis down to Program coordinates X=1,
Y=1, Z=0.25, Machine coordinates X=1,

Y=1, Z=-3.0

GO01 X3 Y3 Z-1F20 Linear interpolation to Program coordinates
X=3, Y=3, Z=-1, Machine coordinates X=3,
Y=3, Z=-4.25

G28 20 Rapid move in the Z axis only to Program

coordinates X=3, Y=3, Z=3.25, Machine
coordinates X=3, Y=3, Z=0

MO06 T3 Change the tool to tool #3 (all coordinates
remain unchanged, and the spindle is turned
off)

G43 H3 Apply the tool length compensation for tool

#3. The offset amount is -1.250 (1.000-
2.250). The tool does not move. However,
the Program coordinates change to X=3,
Y=3, Z=4.5. The Machine coordinates
remain unchanged at X=3, Y=3, Z=0

MO03 Turns on the spindle

G29 X4Y4 70 Move the X and Y axes across and the Z
axis down to Program coordinates X=4,
Y=4, Z=0, Machine coordinates X=4, Y=4,

Z=-4.5

GO01 X5 Z-1 Linear interpolation to Program coordinates
X=5, Y=4, Z=-1, Machine coordinates X=5,
Y=4,Z=-55

G28 Move the Z axis up and the X and Y axes

across to the Tool Change Position, Program
coordinates X=2, Y=2, Z=4.5, Machine
coordinates X=2, Y=2, Z=0
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G49 Cancel Tool Length Compensation. The Z
axis Program coordinate changes by -0.500,
the difference in Length Offset between the
current tool (#3: 1.000) and the tool
displayed in the Current Tool pull-down
menu when the program first began (#1:
1.500). The new Program coordinates are
X=2, Y=2, Z=4. The Machine coordinates
remain unchanged at X=2, Y=2, Z=0. At
this point the current tool should be removed
from the spindle

G52 Local Coordinate System

The G52 command defines and activates a local coordinate system that FlashCut
uses in place of your original Program coordinates for all absolute positioning
moves. The X, Y, Z and A parameters indicate the offset from your original
Program Zero location to the origin for the local coordinate system.

For example, "G52 X1 Y2 Z-4" would activate a local coordinate system whose
origin is at a distance of 1, 2, -4 from the original Program Zero.

All absolute moves are made relative to the new local coordinate system. To
cancel use of the local coordinate system in the middle of a G-code file, use the
command “G52 X0 YO0 Z0 A0 (using only the letters for axes used on your
machine).

When FlashCut reads a G52 command, it displays a magenta dot in the Toolpath
View Port showing the origin of the local coordinate system.

Note that the local coordinate system only applies to the G-code file being
executed. The G52 command has no effect on the Program Zero you set before
running the G-code file. FlashCut automatically cancels the local coordinate
system when it completes execution of a G-code file.

Example:

GO01 X1.0Y3.0Z-1.5F12  Moves the tool to Program coordinates
X=1.0, Y=3.0, Z=-15

G52 X3Y-720 Activates a local coordinate system with
origin at X=3, Y=-7, Z=0 relative to
Program Zero (the machine tool does not
move)

G01 X1.0 Y10.0 Z22.0 Moves the tool to the point X=1.0, Y=10.0,
Z=2.0 relative to the local coordinate system
as defined by the G52 command above
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G52 X0 YO0 Z0 Cancels use of the local coordinate system.

All absolute moves are again relative to
Program Zero as you set it before running
the program

G73, G80, G81, G83, G98, G99 Canned Cycle Commands

Canned cycles simplify programming by letting you specify standard machining
operations with a single command. FlashCut currently supports the following
canned cycle commands:

G73
G80
G81
G83

High Speed Peck Drilling Cycle
Cancel Canned Cycle

Drilling Cycle

Peck Drilling Cycle

The following diagrams illustrate the sequence of moves for the three drilling
cycles. The rest of this section refers to these diagrams.

Initial Point &~ — —be Hole Start Point Y SE— Initial Level
I |
| (G98)
\ 4 |
7y R Level
| Top of Workpiece
I
I
I
(G99)
I Key
| |
| |
| |
' :
\ 4 ' Z Level \4
Feedrate Rapid
Move  Move
G81 Drilling Cycle
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The general command syntax is as follows:
Gn Xx Yy Rr Zz Qq Ff LI

where the parameters are

n: Canned cycle number (73, 81 or 83)

x: X coordinate of Hole Start Point (G90 mode) or distance for rapid move from
Initial Point to Hole Start Point (G91 mode)

y: Y coordinate of Hole Start Point (G90 mode) or distance for rapid move from
Initial Point to Hole Start Point (G91 mode)

r: Z coordinate of R Level (G90 mode) or distance for rapid move from Hole
Start Point to R Level (G91 mode)

z: Z coordinate of Z Level (G90 mode) or distance from R Level to Z Level
(G91 mode)

g: Depth of cut for each downward cutting move (G73/G83 only)
f. Feedrate for each downward cutting move

I:  Number of times to repeat the canned cycle (G91 mode only)
The required parameters are R, Z, F and Q (G73/G83 only).

The G98 and G99 commands affect the final Z axis rapid move, upward out of the
completed hole (rightmost move in each diagram), as follows:

G98: Z axis moves up to the Initial Level
G99: Z axis moves up to the R Level

G98 and G99 compose a mode group, with G98 being the default if neither is
specified in the G-Code file. You can include either command on the same line as
the canned cycle command (before or after the canned cycle command and all
parameters).

The D distance is specified in the G73/G83 Retract Distance field in the G/M
Code Setup dialog box.

Example (assumes D is 0.050 in.):
Go8 Optional

G00 X0.0 Y0.021.0 Moves the tool to the Initial Point, Program
coordinate X=0.0, Y=0.0, Z=1.0 (not
required, for illustration only)
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G83 X1.0 Y2.0R0.1 Z-1.0 Q0.5 F8.0

First moves the tool to the Hole Start Point,
Program coordinates X=1.0, Y=2.0, Z=1.0.
Then peck drills a 1.0” deep hole (rapid
down to 0.1, feedrate down to -0.4, rapid up
to 0.1, rapid down to -0.350, feedrate down
to -0.9, rapid up to 0.1, rapid down to
-0.850, feedrate down to -1.0, rapid up to
1.0)

When using the canned cycle commands, there are several things to keep in mind:
e (73, G80, G8land G83 compose a mode group.

e (80 cancels the active canned cycle command. The G00, G01, G02
and G03 commands also cancel the active canned cycle command.

* While a canned cycle command is active, the command and its R, Z,
Q, F, and L parameters do not need to be repeated on every G-Code
line. However, the X and/or Y positioning parameters must be
included, and must start the G-code line for the line to be interpreted as
a canned cycle command.

Example (drills 3 holes in a row along the X axis using the G81 cycle):
G81 X1.0 Y2.0 R0.25 Z-0.5F5
X2.0
X3.0

* When you switch to a new command in the mode group, you must
include all parameters required for the command.

» The feedrate set by the F parameter for any canned cycle command
remains as the current feedrate for subsequent GO1, G02 or G03
moves, unless you explicitly set F to another value for the next move.

G90 Absolute Positioning Mode

The G90 command puts the system into absolute positioning mode. All XYZA
coordinates are treated as points relative to Program Zero (or a local coordinate
system set by the G52 command). This command stays in effect until a G91
command occurs.

Note that absolute positioning is the default positioning mode for FlashCut. It is
not necessary to include this command in your G-code file if all your moves are
absolute.
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G91 Incremental Positioning Mode

The G91 command puts the system into incremental positioning mode. All
XYZA coordinates are treated as incremental move distances. This command
stays in effect until a G90 command occurs.

Example:

GO01 X1.0Y3.0Z-1.5F12  Moves the tool to Program coordinates
X=1.0, Y=3.0, Z=-1.5 (G90 is assumed)

G9o1 All XYZA coordinates after this command
will be interpreted as incremental distances.
G01 X1.0Y2.02-05 Moves the tool a distance of X=1.0, Y=2.0,

Z=-0.5 from the current tool location (this
corresponds to the Program coordinates
X=2.0, Y=5.0 Z=-2.0)

G02 X1.0 Y-1.010.5J-0.5  Moves the tool using counter-clockwise
circular interpolation to the Program
coordinates X=3.0, Y=4.0, Z=-2.0 with a
center point at Program coordinates X=2.5,

Y=45, Z=-2.0.
G90 All XYZA coordinates after this command
will be interpreted as Program coordinates
G01 X1.0Y2.0 Z-0.5 Moves the tool to Program coordinates

X=1.0, Y=2.0, Z=-0.5

MO0 Program Pause

The MO0 command pauses processing of the G-Code program. By default,
FlashCut displays a dialog box to inform you that it has paused processing. You
can control whether or not this dialog box appears using the Message on M00
Program Pause checkbox in the G/M Code Setup dialog box.

M30 End of Program

The M30 command ends processing of the G-Code program and automatically
resets the program to the first line.

M98, M99, M02 Subroutine Commands

Subroutines allow you to eliminate repetitive programming. FlashCut supports
the use of subroutines with the M98, M99, and M02 (or M30) commands. Use of
these commands is best explained through a simple example. The following G-
code program uses one subroutine called "mysub™:
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Example:
GO01 X1 Y1F10 First line of main program
M98 Pmysub Jump to subroutine “mysub”
G01 X0 YO0 Continued execution after “mysub” ends
MO2 End of main program
Omysub First line of the subroutine called “mysub”
GO01 X2 Y2 Continued execution within the subroutine
M99 End of subroutine “mysub”

In the main program, the M98 command causes program execution to jump to the
first line of the subroutine named "mysub”. Notice that the letter "P" must
immediately precede the name of the subroutine with no spaces.

The subroutine definition begins with the letter "O" followed immediately by the
subroutine name with no spaces. The subroutine must end with the M99
command as shown. M99 causes program execution to jump back to the main
program, continuing with the line immediately following the M98 line (G01 X0
YO above).

When subroutines are used, the main program must end with M02 or M30, the
"End of Program” commands. Subroutine names may include up to 10 alpha-
numeric characters. You can "nest" subroutines as much as you like, meaning one
subroutine may call another subroutine, which in turn may call another
subroutine, and so on.

To call the same subroutine multiple times, include the L parameter as shown
below.

Example:

M98 Pmysub L10 Execute subroutine “mysub” 10 times

This feature provides a simple means to repetitively loop through any block of G-
Code. Just place the G-Code in a subroutine, then call the subroutine with the L
parameter set to the number of loops required.

It’s sometimes convenient to place subroutines in files separate from the main G-
Code file. These files are called included files, and you may use as many as you
like. You must list each included file at the top of the main G-Code file using the
following syntax:

#[file path and name]

Once a file has been included in the main G-Code file, FlashCut treats the
included file’s subroutines the same as if they were listed at the bottom of the
main G-Code file. If you leave out the path, FlashCut will look for the file in the
same folder as the main G-Code file.
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Example:
Main G-Code File (Engraves “A B”)
#C:\GCODE\ALPHABET.FGC
G00 X0 YO0
M98 PmakeA
G00 X1YO
M98 PmakeB
MO02

ALPHABET.FGC File

OmakeA

Go1

[Incremental G-Code to cut the letter “A”]
G90

M99

OmakeB

Go1

[Incremental G-Code to cut the letter “B”]
G90

M99

Notice that the syntax for calling the included subroutines is the same as for
calling subroutines listed in the main G-Code file.

You may create as many subroutines as you like in the main G-Code file and all
included files, but each must have a unique name.

Flashcut’s support for included files lets you create a library of reusable
subroutines that you can apply to various projects and jobs.



74

FlashCut CNC Section 4 System Programming

M100, M101 Wait for Input Line

The M100 and M101 commands wait for an input line to reach a desired state as
follows:

M100 Wait for normal state
M101 Wait for tripped state

The Signal Generator setting in the System Options dialog box determines the
wiring required for these commands as shown below.

Signal Generator Setting 401A (Inputs 401 (Inputs
Normally Closed) Normally Open)

M100 Waits For Input Line... | Closed Open

M101 Waits For Input Line... | Open Closed

The command syntax is as follows:
M100 Ix
M101 Ix

where X is the number of the input line to monitor.

Examples:
M100 I2 System waits for input line 2 to reach the
normal state
M101 I7 System waits for input line 7 to become

tripped

You must define the specified input line as “Control” in the Switch Function pull-
down menu, in the Input Lines Setup dialog box (see “Input Line Settings” in the
Initial Setup section for more details).

FlashCut uses debounce for these commands. For a switch to successfully reach a
desired state, it must hold that state continuously for the debounce duration. You
can set the M100/M101 Debounce time in the G/M Code Setup dialog box.

The M100 and M101 commands time out once the maximum allowable time has
passed and the input line has not reached the desired state. When the commands
time out, FlashCut halts processing of the G-Code program and displays a
message to the operator. You can set the M100/M101 Timeout duration in the
G/M Code Setup dialog box.

A typical use for these commands is detecting completed motion of an auxiliary
device, such as an indexer.
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MO03, M05, M07, M08, M09, MXX Miscellaneous Device Control

Using the Output Lines Setup dialog box you can define up to 16 M codes to turn
on or off different devices through the output lines. M Codes can also be used for
digital control of devices by turning on or off a group of output lines to be used as
digital input into the control lines of the device. See “Output Lines Settings” in
the Initial Setup section for details on how to set up the M codes.

Typical M codes include:
MO03 Spindle On

MO5 Spindle Off

MO7  Mist Coolant On
MO8 Flood Coolant On
M09 Coolant Off

F Feedrate Command

The F command is used to designate a feedrate. The feedrate set with the F
command is modal (stays in effect until another F command occurs).

For all linear moves, specify the feedrate in inches/minute for English units and
millimeters/minute for Metric units.

Example:

GO01 X4.0Y3.0Z1.0F7.0  Moves the tool to Program coordinates
X=4.0, Y=3.0, Z=1.0 at a feedrate of 7.0
in/min

For any move that includes the A (rotary) axis, specify the feedrate in

degrees/minute. Please see the detailed explanation of rotary feedrates under
“GO01 Linear Interpolated Feedrate Move” above.

Program Comments

You can add comments to your program by enclosing them in parentheses.
FlashCut ignores anything enclosed in parentheses as shown below.

Example:
(Move to beginning of the next feature)
GO0 X1.0 Y3.0 (Ready to move Z axis down)
G00 Z-1.5
(Begin next feature)
G01 Z-1.6 F8
G01 X3.0Y75
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Section 5. Tutorial

Starting FlashCut CNC

Windows 3.1 or 3.11

To start FlashCut CNC, double-click on the FlashCut CNC icon in the FlashCut
CNC Program Group.

A dialog will appear asking you if you want to start with the Signal Generator
online or offline. Choose the No, Start Offline button. If you’re running the
Demo version, choose Continue.

Windows 95, 98 or NT

To start FlashCut CNC, click on the Start button, select Programs, select FlashCut
CNC, and then select the FlashCut CNC icon.

A dialog will appear asking you if you want to start with the Signal Generator
Online. Choose the No, Start Offline button. If you’re running the Demo version,
choose Continue.

Welcome |

FLASHCUT CNC §

Version 1.41

Shouid FlashCut CNC establish a
conhnaction to the Sighal Genarator now?

¥Yes, Start Online Ho, Start Offline

Copyright & 12997-1999WP| Inc. Al vights reserved.

Configuring FlashCut CNC

1. Refer to the |nitial Setup|section of this manual to properly configure
FlashCut and your Signal Generator. If you’ve already made a setup file, or

want to use a predefined setup file do the following:
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2. Choose Open Setup from the File menu.

§ FlashCut CMC - Mo G-Code File

File Setup Controller  Wiew Coord)

Open G-Code...  Chl+0
Cloze G-Code

Editar... Chil+E

Open Setup...

Save Setup
Save Setup ba...

Irnport DE=F... Chrl+l

E xit
| T —10

3. Select the drive and directory where the setup file is located, then select the
file and choose OK. Some setup files are supplied for various mills and
lathes. If a setup file is not available for your machine, select
FLASHXXX.STP, where “XXX” is the current software version (e.g.
“FLASH141.STP” for version 1.41). You can easily configure the setup
parameters in this file for your machine tool. If you’re running the Demo
version, you can use the default parameters.

4. Go through the Setup dialog boxes as described in the [Initial Setup|section.

5. Choose All Coordinates from the View menu to make sure all four coordinate
systems are displayed.

Loading a G-Code File
1. Choose Open G-Code from the File menu.

¥ FlashCut CNC - No G-Code File 0
File Setup Conboller iew Coording
Open G-Code...  Chl+0 |
Cloze G-Code
Editor... Clrl+E
Open Setup...
Save Setup
Save Setup Az
Irnpart DEF .. Chrl+l
E xit
| 1 I
2. Go to the directory where FlashCut is installed and double-click on the file
TUTOR.FGC.

FlashCut will load TUTOR.FGC and the screen should now look like this:
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F FlashCut CHC - TUTOR.FGE - FLASHTA S TP
Fis Sep 0 L der o Connds Help
‘ N Program _=et | 0 | Machine e | o |
- X 0.0000 |X H/A
z T 0.0000 (T H/A
z 0.0000 |2 H/A
= A 0.000 A H/A
| i | Relative = | | DistTo Go
o e S ' l[x  o.o000fx ©0.0000
¥ 0.0000 (Y 0 .0000
' 0.0000 |2 0 .0000
-1 A 0.000 |A Q.000
-8 Imm.“ | Cef Tl
e - . . - .
o1 2 3 2 y| GCd| Jog | Point | Hgme | Aug |
(Tutogiml Eile) - Cousiw, T |H|:l_|'.|:|':llll?|.|rl:'“".‘| ﬂ
FL A 0 fuse | Program Fosaratn [T
003 YL.0 10.0 0.5 sowe | [ 100 =] % owemde:[ 0 0 |
300 ¥0.0 0.0 Reset | CSwep Copuous |
=] Siart Fead Hold {Any Kay)

Notice how the G-Code listing appeared in the Program Listing Box and a red
outline of the toolpath appeared in the Toolpath View Port.

Viewing the Tool Path

Before examining the toolpath display let’s zero the Machine coordinates. To do
this:

1. Choose the Zero (0) button to the right of the Machine label in the Tool
Position Box. Choose Yes in the confirmation dialog that follows.

The Machine coordinates, previously shown as N/A, will now be zeroed and a
light blue box will outline the tool envelope in the Toolpath View Port. Because
Scale to Fit is checked in the View menu, you’ll only see a portion of the tool
envelope boundary, as shown below.
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To see the entire machine tool envelope,

then appear like this:

choose Scale to Fit from the View menu,
which removes the checkmark from the Scale to Fit command. The screen will

F FlashCwt CMEC - TUTOR.FGE - FLASHTA STP

M=

Program _Set | 0| Machine o= |]
= 0.0000 X 0. oooo
T 0.0000 Y 0, 0000
g 0.0000 |2 0. 0000
A 0.000 A 0.000
Relative ==t | 0| Dist To Go

o 0.0000 X 0, 0000

-a Y 0.0000 (¥ 0.0000

: - O0.0000 (2 0.0000

‘ A 0.000 |A 0.000

" [Macti ool il [ ot
-5 S TV Ej“'_ﬂJ_Eﬂl_Hﬂm_ﬁujJ
[rataziar exin j‘ Cany, Tkt [0 Toaol Gpacifiead =
GOL .0 I e
003 ¥l.0 I0.0 J0.5 _l | 100 =|%ovemde:[ T 0
300 0.0 *0.0 Feset | CSwp  © Coptinuous |
] Siart Fead Hobd Wy Key) I
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Choose Scale to Fit from the View menu again, to see the largest possible image
of the toolpath.

Now let’s get familiar with the Toolpath View Port. Here are some important
features:

Red Lines - Represent the toolpath for the G-Code program.
Green Dot - Represents Program Zero, the origin of any G-Code program.
Light Blue Dot - Represents Machine Zero, also called Home.

Yellow Dot (not shown here) - Represents the current XY position of the
machine tool during the cutting operation.

Dark Blue Lines (not shown here) - Represent the portion of the toolpath
already cut.

Dotted Lines - Represent a rapid move.
Solid Lines - Represent a feedrate move.
Blue Tool Icon - Represents the current Z axis position (bottom of icon).

Light Blue Lines - Represent the borders of the machine tool envelope.

Animating the G-Code File

Now we’re ready to animate and verify the toolpath on the screen.

1.

Choose the Zero (0) button next to the Program label, then choose OK in the
confirmation dialog box that follows. FlashCut sets all four Program
coordinates to 0. This simulates the tool being in the correct position before
the G-Code program begins.

Choose the G-Cd button in the Control Selection Box to make sure the G-
Code Control Panel is displayed.

Select the Step radio button so FlashCut will execute the G-Code program one
line at a time.

Choose the Start button and watch the blue tool move down the Z axis scale.
Notice that FlashCut has highlighted the next line in the Program Listing Box,
indicating it has fully executed the first line.

Choose the Start button again. Notice the yellow dot, which represents the
current position of the tool, and the solid blue line, which represents the
cutting move just executed.

Select the Continuous radio button, then choose the Start button again. The
yellow dot quickly moves along the toolpath to completion, and the path is

traced in blue as it’s cut. At the end of the G-Code program, the computer

will beep, indicating the file was successfully processed.
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Editing a G-Code File

Now let’s get familiar with using the FlashCut editor.

1. Choose Editor from the File menu. The editor dialog box will appear.

File

§ Edit TUTOR.FGC

01
01
03
GO0
GO0

[Tutorial file])

-2.25 F5.0
4.0

¥i.0 Io.o Jo.5
Z0.0

0.0 ¥0.0

Update Tool Path Exit

2. First, let’s reduce the cutting depth from 2.25” to 0.25”. With your mouse or
your arrow keys, move the cursor to the first line of G-Code that reads: G01
Z-2.25 F5.0. Change it to read: GO1 Z-0.25 F5.0. Then choose Update Tool
Path at the bottom of the editor dialog box. Notice how the red line along the
Z Scale, which shows the total length of Z travel, shrinks down to 0.25” long.

3. Now,

let’s change the diameter of the arc we’re cutting. Move the cursor to

the line of G-Code that reads: G03 Y1.0 10.0 J0.5. Change it to read: GO3
Y2.010.0J1.0.

4. To save your changes:

1.

Choose Save G-Code As from the editor’s File menu.

2. Choose the drive you want from the Drives pull-down menu.
3. Click on the folder you want in the Folder box.

4.

5. Choose OK.

Type “TUTOR2.FGC” in the File name box.
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5.

To close the editor, choose Exit.

Going Online

Now you’re ready to have FlashCut establish communications with the Signal

Generator. This will put FlashCut into Online mode. Note that when the Signal
Generator is online, all moves will be performed by the machine tool. If you’re
running the Demo version of FlashCut or do not have the means to go online at
this time, ignore this section and continue with “Using the Jog Controls|’ below.

1.

Make sure that Signal Generator is securely connected via serial cable to the
correct serial port, as described in the [Initial Setup|section of this manual.

Turn on the Signal Generator.

Choose Online from the Controller menu.

¥ FlazhCut CNC - No G-Code File Ope

Fil=  Setup | Controller iew Coordinates

21 Online

v Offline
ol

Input Status...

10

After a short wait, FlashCut will display the Safety First message. Please read
the message carefully. If you agree with the safety guidelines, click Agree.

Using the Jog Controls

The jog controls let you manually position the tool anywhere within the machine
tool envelope.

1.

Choose the Jog button in the Control Selection Box. FlashCut displays the
Jog Control Panel.

Select the Slow radio button. The machine tool will move at the Slow Jog
Rate defined in the Feedrate/Ramping Setup dialog box. If you are offline
and/or running the Demo software, the jog rate on the screen will be very fast
(determined by the speed of your computer).

Check the machine tool to make sure there’s enough room to move the tool in
the Z+ direction. If there is enough room, click down, hold and then release
the Z+ Axis Jog button. Notice how the tool moved up and the Z Program
and Relative coordinates changed. Also notice how the machine moved until
you released the button. If the tool went down instead of up, change the
Motor Polarity for the Z axis in the Motor Signal Setup dialog box. Note that
if Machine coordinates are properly set, FlashCut will not let you move
beyond the machine tool envelope. Also note that you can jog the machine
using the keyboard. The controls are mapped as follows:
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X+  Ctrl + Right Arrow Key
X- Ctrl + Left Arrow Key
Y+  Ctrl + Up Arrow Key
Y- Ctrl + Down Arrow Key
Z+ Ctrl + Page Up Key

Z- Ctrl + Page Down Key
A+  Ctrl + Plus (+) Key

A- Ctrl + Minus (-) Key

4. Try jogging in all directions on all axes, making sure you have enough room
in the direction of travel before you choose each Axis Jog button.

5. Now select the Fast radio button and repeat the same exercise. The tool will
move at the Fast Jog Rate defined in the Feedrate/Ramping Setup dialog box.

6. Position the tool so there is at least 1” of room in the positive Z direction.

7. Now let’s set the current position as Program coordinates X=0, Y=0, Z=1.
First, choose the Set button next to the Program label in the Tool Position
Box. Then choose the Zero X and Zero Y buttons. Finally, enter 1.0000 in
the Z text box. Choose OK to exit the dialog.

8. Now let’s use the Axis Jog buttons to move the tool up exactly 1.0000”. It’s
convenient to use three jog rates to do this: Fast, Slow and Single Step.

9. While the jog rate is still set to Fast, move the tool up until the Z axis Program
coordinate is close to 2”.

10. Now change the jog rate to Slow and do the same to get even closer to 2”.

11. Finally, change the jog rate to Single Step. FlashCut will move the tool
exactly one step each time you choose one of the Axis Jog buttons.
Repeatedly choose either the +Z or -Z Axis Jog button until the tool is exactly
at Program coordinate 2.0000 on the Z axis. Depending on the tool
positioning resolution of your machine tool, you might not be able to reach
2.0000 exactly.

12. Now use the same process to move the tool exactly 0.5000 inches in the +X
direction and 0.2500 inches in the +Y direction. The Program coordinates
should now read:

X: 0.5000
Y: 0.2500
Z: 2.0000

Setting Machine Zero

You can set Machine zero two ways: by jogging the tool to the corner of the
machine tool envelope, or using the Seek Home button on the Home Control
Panel. In this tutorial we will jog to a point and define it as Machine Zero.
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© g ~ w

Choose the Clear button next to the Machine coordinate label in the Tool
Position Box. This will clear the Machine coordinates and remove the light
blue machine tool envelope boundary.

Choose the Jog button in the Control Selection Box.

Jog the tool to 1/10” from the top of the Z axis.

Jog the table in the X- direction to about 1/10” from the end of travel.
Jog the table in the Y- direction to about 1/10” from the end of travel.

Choose the Zero (0) button to the right of the Machine coordinate label. Then
choose OK in the confirmation dialog box that follows.

Using the Point Move

The Point Control Panel provides an easier way to move the tool to an exact
position.

1.

2
3
4.
5

Choose the Point button in the Control Selection Box.

Select Any Point in the Point list.

Select Machine from the coordinate system pull-down menu.
Fill in the X, Y and Z text boxes to read 1, 2, and -1.

Enter “4” in the Linear Feedrate text box. Now everything is ready to move to
Machine coordinates 1, 2, -1 at a feedrate of 4 inches/minute.

G X E—Cd' Jog | Euint| Hgme' ﬂ-«ug'

i II'I.I'Ia[:hinE j IFeedratE j
Machme Zoro X[ 000 i [150 |iwii
g (YOm0
Cure. ine St | 1100 [n | Move

Last Feed Hold A II:I.I:IEIEI ® Feed Hold

Choose the Move button. Notice how the machine first performed 2-Axis
linear interpolation for the X and Y axis, then moved the Z axis down. This
sequence of movement, unique to the Point mode and G28/G29 commands,
helps to avoid tool crashes.

Select Machine Zero in the Point list.

Select Rapid from the Rate Mode pull-down menu. Everything is set to move
the tool to Machine coordinate 0, 0, 0 as quickly as possible.
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b X Q—Cd' Jog | Euint| Hgme' Aug'

Any Point [Machine =] [Rapid =

Program Zero
xlIII.EIEIIIIIII in |4.DD infrmin

Relative fero _ "
Tool Change Y ID-DDDD In I?EEI.EI fmin

Program Start ID EI_EIEIEI :
Curr. Line Start Z" I Move

Last Feed Hold A IIZI_EIEIEI = Feed Hold

9. Choose the Move button. Notice how the machine first moved the Z axis up
and then performed 2-axis linear interpolation on the X and Y axes.

Setting Program Zero on the Machine Tool

Program Zero is the origin to which all Program coordinates in the G-Code file
are referenced. Before we cut a part, Program Zero must be set correctly relative
to the workpiece. For this tutorial we will cut a file called FLASHBLT.FGC.

1. Choose Open G-Code from the File menu and select FLASHBLT.FGC, then
choose OK. The screen appears like this:

F FlashCut CHE - FLASHBLY FIGC - FLAGH141. 5T HF.'I-.'.I
[le Sewp Conbcle Muw Coordpeter Hel
‘ * Program _Sd | o | Machine cew | 2|
ol X 0.0000 (¥ 0.0000
T 0.0000 |7 0., 0000
g 0.0000 |2 0.0000
: N a4 A o.o00 |A i0.000
Relative s« | 0| DistTo Go
S F ® 0.0000 X 0.0000
-1 { T 0.0000 |¥ 0 .0000
! = 0.0000 (2 0.0000
a A 0.000 (A Q.000
¢
o i x| GCd| Jog | Point| Hgme | Auy |
(flaahblE. Fge) o i wchilmn - -
(Hade To Enjl.:r-'e 0,05 deep) j :T:T:::.zﬂu e g raphd =
[iuda in LSBT &b Huiékaz plaskEis) I[ i I nran
[use 1/167 End Eill]
I e
GO0 ¥ 0.0000 ¥ 0, 1250 in K |
HlL £ -0.02% F Z.00 -
GOL X 0.0000 ¥ 1.5000 F 4.00 | fLostFeed Hold | : |. =L J

2. Make sure there is enough room on all axes of the machine to run this G-Code
file from the Program Zero point. By observing the toolpath displayed in the
Toolpath View Port, you’ll see the FLASHBLT.FGC program needs +2.125
inches on the X axis, +1.625 inches on the Y axis, +0.5 and -0.05 inches on
the Z axis.
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Fixture a sheet of 1/8” or thicker plastic or aluminum at least 2” wide and 4”
long onto the XY table of the machine tool. Be sure that all clamps and
fixtures are well out of the way of the tool during all parts of the program.
This program works best with a 1/16” endmill.

Jog the tool to the -X, -Y corner of the workpiece using the Jog Control Panel.
Then carefully jog the tool down in the Z axis until it just barely touches the
top of the workpiece.

To define this point as Program Zero, choose the Zero (0) button next to the
Program label, then choose OK in the dialog that immediately follows.

Using either the Jog or Point Control Panel, raise the Z axis exactly 1.0” and
define this point as Program Zero. Note that this point is exactly 1" above
where it needs to be to actually cut the workpiece. The machine is now ready
to do a dry run without cutting the workpiece.

Testing the Program on the Machine Tool

It is always a good idea to do a dry run of the G-Code file both in offline and
online modes before cutting a part. This lets you check for G-Code programming
errors, spot interferences with fixtures, and so on.

Choose the G-Cd button in the Control Selection Box.

1.

Choose the Reset button to make sure the G-Code program is reset. Choose
OK in the dialog that follows.

Take the Signal Generator offline by choosing Offline from the Controller
menu.

Go into step mode by choosing the Step radio button.

Repeatedly choose the Start button, watching the screen to make sure the tool
behaves properly.

Once you are satisfied the program will behave properly, re-establish
communications with the Signal Generator by choosing Online from the
Controller menu. A dialog will ask you if you want to revert to the
coordinates used before going offline. Choose Yes.

Choose the Step radio button.

Choose the Start button. The machine should move the X and Y axes, then
stop.

Step through the entire program by choosing the Start button for every line of
G-Code. If at any time you need to stop the tool, choose the Feed Hold button
or hit any key on your keyboard. If you stop the tool in the middle of the
program, you can start exactly where you left off by choosing the Start button.
You may want to try this for practice.
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Cutting the Part

Assuming everything was fine in the previous step, we’re ready to cut a part.

1.

Check to make sure the Program coordinates are at 0,0,0. If not, go through
the “Betting Program Zero on the Machine Tool]’ section above.

Go into jog mode and carefully move the tool down in the Z- direction to the
part surface. This should be at the program coordinate 0,0,-1.

Set this point as Program Zero by choosing the Zero (0) button next to the
Program label and choosing Yes in the dialog that follows.

Now jog the tool 0.5” UP (in the Z+ direction). This places the tool in the
correct starting position to begin cutting the workpiece.

Choose the G-Cd button in the Control Selection Box.
Choose the Continuous radio button.

Turn the machine tool spindle on and make sure everything is ready on the
machine tool.

Choose the Start button and the machine tool will begin to cut out your first
part. Always be on alert to choose the Feed Hold button or hit any key in
case of emergency.

Congratulations! You’ve successfully cut your first part using FlashCut.

Exiting the Program

To exit FlashCut CNC, choose Exit from the File menu. This terminates
communications with the Signal Generator and returns you back to Windows.

Turning off the Electronics

Always turn off the Signal Generator and Motor Driver when
they are not in use.
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Section 6. Glossary

Backlash - The amount of motor movement that occurs without table movement when
changing directions on an axis. A typical source for backlash is play between the screw
and nut in the drive system.

Baud Rate - The speed at which FlashCut communicates across the serial port with the
Signal Generator. It’s measured in bits per second and is typically set at 38,400.

Buffer Time - The Buffer Time is used to prevent system events from affecting motor
movement. The larger the Buffer Time, the less effect system events have on motor
movement. The smaller the Buffer Time, the more responsive the machine tool is to
mouse clicks.

CNC Setup Parameters - FlashCut CNC settings that define a machine tool and it’s
operating limits. All setup parameters are found in dialog boxes available from the Setup
menu. The coordinate display mode and the scale to fit setting are also saved in the setup
file.

Command Buttons - Buttons that perform a task when chosen.

Continuous Contouring - A high performance operating mode that lets FlashCut run G-
code files smoother and faster. Smooth transitions from one G-code line to the next
allow high speed machining of complex 2D profiles and 3D surfaces. Also called “Look-
Ahead” and “Constant Contouring.”

DXF - Document eXchange Format. Defined by AutoDesk Inc. as a way to exchange design
data between CAD, CAM and CAE programs.

Feedrate - The linear speed of the cutting tool relative to the workpiece. Defined in G-Code
by the F parameter in inches/minute, millimeters/minute or degrees/minute.

Full-Step - Step mode where one step from the Signal Generator corresponds to one full step
of a stepper motor.

G-Code - Standard programming language used to control CNC machines.

G-Code Program - Program used to control the movement of the machine tool. G-Code is
an industry-standard machine tool programming language.

Gear Ratio - The ratio of motor revolutions to drive screw revolutions due to gears, pulleys
or other devices.

Half-Step - Step mode where two steps from the Signal Generator correspond to one full
step of a stepper motor.

Included File - G-Code file containing subroutines that can be called from a main G-Code
file. The included file must be listed at the top of the main G-Code file.

Jog - Method of manually controlling each axis of the machine tool.

Limit Switches - Switches placed at the travel limits of each axis. When the machine tool
travels too far in either direction of any axis, a limit switch is tripped. The control system
then stops the machine to prevent damage.

Machine Coordinates - The XY ZA position of the tool relative to Machine Zero.
Machine Origin - Same as Machine Zero.
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Machine Tool Envelope - The three dimensional box (plus optional 4™ axis travel) defined
by the maximum travel in the X, Y, Z and A axes. Once the machine tool envelope is
defined, the tool cannot move beyond it. You can disable the machine tool envelope by
choosing the Clear button.

Machine Zero - The origin (X, Y, Z, A=0, 0, 0, 0) of useful space within the machine tool
envelope. Can either be defined manually or by using home switches.

Maximum Feedrate - The maximum rate at which a motor can reliably start and stop with
ramping.

Maximum Unramped Feedrate - The maximum rate at which a motor can reliably start and
stop without ramping.

Modal - A type of command that stays in effect while FlashCut processes subsequent G-
Code commands.

Motor Driver - The electronic box that converts step and direction signals from the Signal
Generator into a sequence of amplified signals to drive a motor.

Motor Polarity - The association between the actual direction an axis moves and the
direction FlashCut intends it to move. If they are different, this setting should be changed
from positive to negative or vice-versa.

Motor Resolution - The number of full motor steps for one revolution of the motor. For
example, a 1.8° Stepper motor has 200 full steps per revolution, a 0.9° Stepper Motor has
400 full steps per revolution, and so on.

Motor Step - The amount of motor movement associated with one electrical pulse to the
stepper motor driver.

Offline - Mode in which FlashCut does not communicate with the Signal Generator.
FlashCut displays all G-Code, Jog, and Point moves, but the machine tool does not move.

Online - Mode in which FlashCut communicates with the Signal Generator. In this mode, all
G-Code, Jog and Point moves are executed by the machine tool.

Open Loop - A type of control system in which an actuator moves without sending motion
information back to the controller. Most stepper motor systems are open loop due to their
high reliability in performing step commands when used within their torque limits.

Program Coordinates - The XY ZA position of the machine tool relative to Program Zero.

Program Listing Box - The area of the main screen that displays the G-Code program
currently loaded into FlashCut.

Program Zero - The zero point, or origin, to which all absolute coordinates in the G-Code
file are referenced. It is depicted as a green dot in the Toolpath View Port.

Pull-Down Menu - A standard Windows control that lets the user select a single item from a
list.

Radio Buttons - Buttons representing a group of options requiring a single selection.

Ramping - Smooth acceleration that allows a machine tool to reach high feedrates. Ramping
rates are measured in full steps/sec/sec.

Relative Coordinates - The XY ZA position of the machine tool relative to the point at
which the Relative Coordinates were zeroed. The relative coordinate system is general
purpose and may be used for anything you choose (as long as it’s legal).
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Resonant Speeds - Rotational speeds at which a stepper motor vibrates excessively. Often
the motor will stall if run at these speeds. Resonant speeds depend on the size of the
motor, the amount of loading, and the power of the motor driver. Typically, increasing
the load and reducing motor driver current will reduce resonance.

Screw Thread - The number of turns per unit length of travel of the helical drive screw for
each axis.

Serial Port - A communications port on both the PC and the Signal Generator, used to
exchange commands and other information.

Setup File - A file containing the CNC Setup Parameters for a machine tool. These files
have a “.STP” extension by default.

Signal Generator - The electronic box that converts computer commands into step and
direction signals suitable for a stepper or digital servo motor driver. It also interprets
input line signals and produces output signals to control various peripheral devices.

Step Mode - The number of micro steps between each full motor step.

Stepper Motor - A motor that moves a precise amount when given an electrical pulse.
Stepper motors typically have 200 full steps per revolution, or 1.8° per full step. Other
popular stepper motors have 0.9° and 7.5° per step.

Text Boxes - Areas in which you type either a name or a value.

Tool Position Box - The area of the main screen that shows the current coordinates of the
tool on the machine tool. You can display one or all of the four coordinate systems in
this box.

Tool Positioning Resolution - The amount of machine tool movement that results from one
step pulse produced by the Signal Generator. For each axis, Tool Positioning Resolution
(TPR) depends on 4 factors: Step Mode (SM), Gear Ratio (GR), Motor Resolution (MR),
and Screw Thread (ST), where

TPR=1/(SM * GR * MR * ST)

Toolpath - The path that a machine tool follows as FlashCut executes a G-Code program.

Toolpath View Port - The area of the main screen that graphically displays the toolpath in
real time.
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